Aurora Multi-image
System Control
Software

User Manual






DSPRosEE TECHNOLOGY CO., LTD.

Product Information

Model: Aurora Controller Software

Version: V010200
Release Date: January 18th, 2017

Company
OSEE TECHNOLOGY CO., LTD.

Contact Information
Address: No.22 Building, No.68 zone, Beiging Road, Haidian District,

Beijing, China
Post Code: 100094
Tel: (+86) 010-62434168
Fax: (+86) 010-62434169
Web: http://www.osee-dig.com/

E-mail: sales@osee-dig.com



About this manual

Important

The following symbols are used in this manual:

B Tips

* The further information or know-how for described subjects above which

helps user to understand them better.

——

* The safety matters or operations that user must pay attention to when

using this product.

Contents

The user manual applies to the following device types:
Aurora9600
Aurorale00

The images of Aurora multi-image system editor are adopted in the following
descriptions.

Any of the different specifications between the device types are elaborated.
Before reading the manual, please confirm the device type.
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Chapter 1 Overview

Auroral600 and Aurora9600 are controlled using Aurora control software
which is running in the remote control computer using Windows system
software. Aurora is simple to use and easy to learn, through its use of simple
drag and drop control.

The Aurora controller and its inner control software compose the Multi-view
system, the device integrates an internal control software to connect to and
configure the controller. You can configure multi-windows and multi-scene with
the input video sources, and set them at any position and in arbitrary size in
the operating interface of the software. Each video window has adequate
resolution to show very high quality frame effects. The software is a WYSIWYG
editor and easy to use.

It is widely used in the following fields: educational and research, public
announcement, publication and information, administrative management,
military command system, exhibition and presentation, security surveillance
system, appliances sales etc.

Figure 1 A Diagram of Display Wall

Features

B Image can be displayed anywhere, any size, within or cross screens.
The window of a video source can be moved from one screen to
another screen in real time

B Supports various customized scene models, including position, size
and stacked relationship of the input video windows.

B Support several types of timers: analog clock timer, digital clock timer,
countdown timer, and digital data timer.

B Supports MARKER, Time Code, MET display
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Chapter 2 Startup and Software Interface

2.1 Device Connection

1. Multi-image Processor and Lines

According to the customer's requirements, connect the signal sources with
the input interfaces, and connect the signal outputs to the target display
screens. The AURORA9600 and AURORA1600 configured full are
respectively shown as in Figure 2.1-1 and Figure 2.1-2.
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Figure 2.1-1 The Rear Panel of AURORA9600 in Full Configured
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Output Output
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Figure 2.1-2 The Rear Panel of AURORA1600 in Full Configured

B Tips

* The slots for the input modules and the output modules are different, so they

can't be inserted mixed, and the interfaces of the display screens and the

signal sources should be corresponding in sequence.
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2. Multi-image Processor and Control Computer

Connect the multi-image processor and its control computer with
twisted-pair cable.

BTips

* The multi-image processor and its control computer must be at the same

network segment.

* The default IP address of AURORA1600 multi-image processor is
192.168.1.70, and the default IP address of AURORA9600 multi-image
processor is 192.168.1.80.

3. Software Operating Environment
B Supports these operating systems: Windows XP, Windows7 or above

B Java Environment: JDK(Java Development Kit) 1.7 or above

2.2 Startup Aurora

2.2.1 Startup Interface

Connect to the control computer, and navigate to the Aurora.exe file under
the folder where the multi-image processor software installed. Double click
Aurora program Fawoera exe  to Start up Aurora multi-image system editor,
and connect to a multi-image processor. It will pop up User Login dialog
box, as shown in Figure 2.2-1:

User Login |
2 admin -

Femember me

Login

Figure 2.2-1 User Login Dialog Box

Input the user name and the password, then click Login button to confirm
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the inputs, it will pop up the Device Connect dialog box, as shown in
Figure 2.2-2, select the target device in the device list in this dialog box,

then click Connect button to confirm the selection, it will connect to the
device.

]]ev:i.t:e Connect

| Search Devices | | Hetwork Card | IF: | | | Add | | Delete |
| Device Name IP Address Subnet Mask Gateway Device Type
: Aurora 192.165.1. 70 255. 255. 255. 0 192.168. 1.1 Auror alG00
: Aurora 192.1658.1. 71 255.255.255. 0 192.1658.1.1 Auroral GO0
| Connect || Close |

Figure 2.2-2 Device Connect Dialog Box

After successful connecting, the interface of Aurora Multi-image System
Editor is as shown in Figure 2.2-3:

Aurnra Hulti-image System Editor
File Configure User Help

F Ard
[ burora

=[] Alarm Config
D Output Format
=[] Serial Fort List
[} sy=ten Config
[y 15L Config

IS[=] E3

| vEvice [ source [ vipeo waiL | ravour |

| Properties

Tame Value

# OnLine

IP: 192.168.1.70

Figure 2.2-3 The Interface of Aurora Multi-image System Editor
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B Tips

Start Aurora multi-image system editor up 30s later after the multi-image
processor powered on, or do the refresh operation in Aurora multi-image
system editor 30s later after the multi-image processor powered on, thus to
ensure the software has read the correct and the newest devices

information.

The last connected device will be listed at the first line of the device list in

the device connect dialog box.

If there are more than one Network Interface in the control computer, it will
pop up the Set Network Card Devices dialog box, please select a
Network Interface for the control computer through which you will connect

to a multi-image processor.

The aurora multi-image system editor will read the information of the input
modules and the output modules connected with the control computer.

1
2
3

7

The interface of Aurora multi-image system editor is divided into the
following areas, as shown in Figure 2.2-4:

Elurwu Holti=image System Editor aj.gjﬁl

— Fls Configurs User Help

Sl eas a

[ huroxa | DEVICE | SOURCE | VIDEQ WALL | LAYOUT Properties ~
o Alers Config =
D, . Hame Value
Ourput Format
Q-ESOY'_II Pert List
D Svitem Config
— [ 15L Confic

& online 1P 152.168.1.70 G .dl..‘:‘ o _Efl.

Figure 2.2-4 The Operation Areas in Aurora Multi-image System Editor

1. Title Bar: it contains the icon, the name of the software, and a group of
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system buttons from left to right separately. These control buttons at the
right end of the title bare are used to minimize/maximize window, restore
window and close window.

2. Menu Bar: it provides the operation commands for multi-image system
configuration. The menu items are File, Edit, View, Tools, Elements,
Configure, User and Help, each contains its sub-menu items in its
drop-down menu:

O File: it provides the common commands used for multi-image
system configuration, such as Open, New, Save and so on.

O Edit: it provides the common edit commands for the Model
configuration, such as Copy, Paste, Select All and so on.

O View: it provides the viewing commands for Video Wall and Model
configuration to control the display size and add auxiliary lines,
such as Zoom in, Zoom Out, Grid and so on.

O Configure: it provides the commands on device connection, timing,
and model switching.

O Tools: it provides the commands to align elements, assist model
arrangement and drawing.

O Elements: it provides the elements for model, such as monitor,
clock and so on.

O User: it provides users with different operating rights for entering
and using this software, the commands containing User
Management, Switch User and so on.

O Help: it provides the assist commands, such as restore factory
default, check device information and software version, and
switching software languages and so on.

3. Tool bar: it provides the shortcuts for menu commands, and click the
shortcut button to activate the corresponding command. The tool bar
shows different shortcuts according to the editing contents in working area
at the center of the software interface.

4. System Pane: it is at the left side of the software interface, providing
the system sources for the content showing in working area.

5. Working Area: it is at the center of the software interface, providing
the workplace for different configuration objects. The configuration objects
are DEVICE, SOURCE, VIDEO WALL and LAYOUT, click the tab labeled
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the object name at the top of the working area to switch to the target
configuration object. The configuration objects achieve the following
functionalities:

O DEVICE: itis used to configure the device information on network,
alarm settings, communication interfaces, output formats and so
on. The alarm configuration are divided into video alarm and audio
alarm: video loss, video freeze, video black, audio loss, audio low
and audio high.

O SOURCE: it is used to configure the signal source information,
including signal source name, audio meter mapping, UMD source
and TALLY source.

O VIDEO WALL: it is used to configure the video wall, including
create, modify, delete, output mapping and configuring video wall
properties.

O LAYOUT: it is used to configure the model, including adding
display elements, elements arrangement and properties
assignment. Particularly, there is a layout bar at the top of layout
working area for model drawing and editing.

6. Property Pane: itis at the right side of the software interface,
providing the properties settings for device, video wall and model.

7. Status Bar: it shows the connection status and address information of
the current multi-image processor, and it provides status tool bar, including
Enable Offline Editor, Restore To Last Auto-saved Configuration,
Refresh Manual Timing and Control shortcuts.

O Enable Offline Editor: Switch to the offline editor window.

O Restore To Last Auto-saved Configuration: Click this
Restore 4| | button to prompt for restoring operation, click Yes

button to confirm the operation, and it will restore to the last
settings to the current project. The configuration file is saved in the
software installation directory as ”..\AURORA\xml\data\backup”.

x|
? Confirm to restore last auto—save cnnfiguratiu:-n’?

ies | o |

Figure 2.2-5 Prompt for Restore
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O Refresh: click this button to reload the newest device information.

O Manual Timing: click this button to timing the multi-image
processor manually. It displays the timing window, as shown in

Figure 2.2-6:
X
Date Time
|_]'a.nua:ry |V| 2017&' ¥ Synchronize System Time:
2 10:17:35
Timing wourself :
12 o mEh ISE 4'5
172 19 20 21 LTC Timinz - "= :
25 26 27 28 £
®  Aute LIC

Figure 2.2-6 Timing Dialog Box

There are three timing methods provided in this dialog box:
Synchronize System Time, Timing yourself and LTC Timing. The
first is to time with the system time, the second is to time with a
customized time set at the left time table in the timing dialog box, and
the last is to time with the LTC time.

Click OK or Apply button to confirm the timing operation, the timing
successful prompt is as shown in Figure 2.2-7 , and the timing failed
prompt is as shown in Figure 2.2-8:

x
@ Save Successfullw

UK

Figure 2.2-7 Prompt for Timing Successfully

x
@ Set Unsuccessfully!

0K

Figure 2.2-8 Prompt for Timing Failure

Click Cancel or the close button*! to close the timing dialog box.
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O Control: Switch to the online controller window.

B Tips

The content displayed in Menu bar, tool bar, system pane, working area or
property pane will be different according to the configuration object
displayed currently in working area, refer to "2.3 Software Interface" for the
details.

2.2.2 Device Connection

Use Connect command in the Configure menu to set up the connection
between the control computer and the target multi-image controller, and
use the Disconnect command to cut down the connection.

The details are described as follows:
1. Device connection status

The aurora multi-image system editor will pop up the device connect
dialog box to set up the connection during startup process. You can check
the connection status and its IP address directly at the Status Bar. There
are two kinds of status:

B  ONLINE: When detecting and setting up the connection with the target
device during startup process, it will show the Online keyword and its
IP address in Status Bar, as shown in Figure 2.2-9:

ElAcrora Bulti-image System Editor o [=] B3]

File Confizwe User Help

Ay @& &

[ Aurors {|(oevice | sowrce | vipeo marL | Lavour |
=[] Alerm Config 2 :
: P Tame Value
D Output Format £ H
& [ Serial Port List : :
[ systen Config
[y 18L config

i| Properties ~

llonLim IP- 192 168.1. 70 |
Figure 2.2-9 Set up Connection

B  OFFLINE: When not detecting the connection, it will show the Offline

10
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keyword and its IP address in Status Bar, as shown in Figure 2.2-10:

EAcrora Bulti-image System Editor o [=] B3]

File Configmwe User Help
|

[ hurora J|(pEvice | source | vipeo wmarL | Latour | | Properties ~

=[] Alerm Config
D Output Format

o [J Serial Port List
[ systen Config
[y 18L config

Name Value

=k

87 OffLine TIP: 192.168.1.70 |

Figure 2.2-10 Disconnection

B Tips

* Make sure all of the operations should be done in online mode, in case of

data lost.

2. Device connection

Using the Device Connect dialog box to set up the connection. The
device connection is divided into two methods: automatic connection and
manual connection. The automatic connection is used during the startup
process, and then when the device address is changed, you need reset
the device connection by manual connection method.

B Automatic connection

The aurora multi-image system editor will detect and try to set up the

connection with the latest connected device during startup process. You
can check the connection status and its IP address directly at the Status
Bar. The latest connected device information will display in the first line.

B Manual connection

Using manual connection when the automatic connection is not
successful or the connection is broken off.

Using the Device Connect dialog box to set up the connection when the
connection is not successful, or the connection is broken off.

Select "Configure"->"Connect" command in menu bar, or click connect
button # | in tool bar, it will pop up the Device Connect dialog box, as

11



shown in Figure 2.2-11. Click Search Devices button | Search Devices | tO
find out the available devices information in the current network.

Startup and Software Interface

It lists the following information: Device Name, IP Address, Subnet Mask,
Gateway and Device Type.

x
T o E—

O | Device Name |

| Search Devices

IP Address | Subnet Mask | Gateway | Device Type |

Figure 2.2-11 Device Connection Dialog Box

You can check a device, select a device or add a new device in the
Device Connect dialog box, the operations are as below:

O Add a new device

Input a new IP address in the field of IP input, then click Add button

Add

, the new will be add into the device list, as shown in Figure
2.2-12. For example, add 192.168.1.70.

m =
]]ev1 ce Conmnect

X

| Search Devices

O Device Name

IP Address Subnet Mask Gateway | Device Type

I:‘ no name

192.168.1. 70 255. 255.255.0

182.168.1.1

|'|]'r|lmo'rn

Figure 2.2-12 Add a New Device

12
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If the format of the IP address is wrong, it will pop up the prompt as
shown in Figure 2.2-13:

x

@ The IP format 1s srong

0K

Figure 2.2-13 Prompt for Error IP Format

If the new IP address is reduplicated, it will pop up the prompt as
shown in Figure 2.2-14:

x

@ The IP Address alreadw exists, do wou want to overwrite 1t?

0K

Figure 2.2-14 Prompt for Reduplicated IP Format

O Delete a device

Click one or more selection icon in front of the device in device list,

then click Delete button | 2&&t®

, it will pop up the confirm prompt,

as shown in Figure 2.2-15, click OK to delete the device, or click
Cancel to give up the delete operation.

x

7

H Do wou want to delete 1t7

0K Cancel

Figure 2.2-15 Prompt for Delete Device

B Add device automatically

Click Search Devices button | S&=ch Devices it will search the

available multi-image processor in the network automatically, and it
will list the available device information in the device list. For example:

13
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click Search Devices button, and the results list as shown in Figure

5
| Search Devices || Network Card | IP:
| Device Hame IP Address Subnet Mask Gateway | Device Type
[ ||ne name 1582.168.1. 70 255, 255, 250. 0 192.168. 1.1 |Ur|kn0'rn
[ ||ne name 182.168.1. 71 255. 255, 250.0 192.168.1.1 |Ur|]-'.rl0'l'rl
[ ||ne name 182.1658.1. 72 255. 255. 255. 0 192.168.1.1 |Ur|]-r.nown
[ |ne name 182.168.1. 73 255. 255, 255.0 192.168.1.1 |Ur|]-mo'rn

Figure 2.2-16 Search Result
B Tips

* If there are more than one Network Interface in the control computer, it will

pop up a prompt “Please choose the Network Interface and try again” at the

first time when you click the Search Devices button. Click OK, and it will

pop up the Device Search Network Interface Config dialog box, please

select a Network Interface for the control computer through which you will

connect to a multi-image processor. And if you want to change the default

selection which you will use to connect to the multi-image processor, click

Setting button, and modify it in the Device Search Network Interface Config

dialog box.

B Select network interface for the control computer

Click Network Card button

Hetwork Card

, It will pop up the Set

Network Card dialog box, as shown in Figure 2.2-17, tick to select a
Network Interface for the control computer through which you will
connect to a multi-image processor. Click OK to confirm the selection

and close this dialog box.
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Plsat Network Card [=]
Interface Name Physical Address IPv4 Address IPvE Address

[ ||ethO(VMware Virtual Ethernet Adapter ...[40:50:56:c3:00:8 192.168.1.43

[]|eth1(VMware Virtual Ethernet Adapter ...[00:e0:56:c0:04:15 192.168.1.22

v] eth2(Atheros ARS151 PCI-E Gigabit E...| 94:de:80:95:83: 11 192.168.1.56

Figure 2.2-17 Device Search Network Interface Config

B Select and connect

Click the device information line, it will be chosen, then click Connect

Connect

button , or double-click the device information line, it will

connect to the selected device.

If the connection is successful, it will pop up a prompt, as shown in
Figure 2.2-18, click OK to confirm the connection. If the connection is
failed, it will pop up a connection failure prompt, as shown in Figure

2.2-19, click OK, please select another device or check the
connection link.

Tis x|

@ Connect And Refresh Successfullw!
IP=192 168.1. 70

0K

Figure 2.2-18 Connect Successful Prompt

Tis x|

@ Connect And Refresh Failed!
IP=192 188.1. 70

0K

Figure 2.2-19 Connect Failed Prompt

B Tips

* The device information line can't be restored even if you do the

Undo(CTRL+Z) operation after you delete it. Please make sure the deletion
operation.

15
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3. Device Disconnect

Use the Disconnect command to cut off the connection between the
control computer and the target multi-image controller.

Select "Configure"->"Disconnect" command in menu bar, or click
connect button| #¥ | in tool bar, it will cut off the connection with the current
multi-image controller. You can see Offline in the status bar.

4. Refresh Device Information

Click the Refresh button {1 | at the bottom right corner of the software

interface as shown in Figure 2.2-20, it will reload the device information
especially when the device changed.

[Enrors Bulti-inage Systes Editor ~=lolx=]

File Configure User Help

LA A=

[ trors ‘| oEvice | source | vipeo waLL | Lavour | Ero
& I Mlarm Config 2

[ output Format eme il
o~ (] Serial Port List
[ sy=tem Confiz

[y 15L Config

# Online IP: 192.168.1.70
Figure 2.2-20 Refresh Shortcut Button

Click the Refresh button £h |, or select Configure>Refresh command, it

will pop up a prompt, as shown in Figure 2.2-21, click OK to confirm the
refresh operation, or click Cancel to cancel the refresh operation.

x
? Insaved %111 bhe lost, are wou sure?
0K Cancel

Figure 2.2-21 Prompt for Refresh Operation

Do the refresh operation in the following situations:

B Refresh to reload the device information if the software has been
started up when device is offline.

16
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Refresh to reload the device information after device changed.

B Refresh to reload the device information after the device configure has
been changed, such as change the input or output module numbers,
change the slot and so on.

2.3 Software Interface

The section will introduce the contents and functionalities of the operation
windows.

The Aurora multi-image system editor provides several interfaces for different
purpose: Configuration Editor, Offline Editor and Control Editor. They will be
described separately as follows.

2.3.1 Configuration Editor

The Configuration window is used to configure device, signal source,
video wall and model.

You can do four kinds of configuration operations in Configuration window:
Device configuration, Source configuration, Video wall configuration and
Layout configuration, click the corresponding tab at the top of the working
area to display the configuration contents.

[ DEVICE |~ SOURCE | ViDEOWALL | LAYOUT |
[ DEVICE [rsoum:z | ViDEO WALL [’LAYOUT |
1D Signal Name Audio Meter 1 | Audio Meter 2 | Audio Meter 3 | Audio Meter 4 |TS
: signal|| DEVICE | SOURCE | VIDEOWALL [ LAYOUT
2 Signal
- ( DEVICE rSOURCE rVIDEOWALL rLAYOUT |
3 Signal
4| signa k @ =l
5 Signal
B Signal
7 Signal me Al iMonitar Mame : {Zhaonitar me Manitor 0
_| : I Lfcetiory: [0,0,960,540] | Location : [860,0,960,540] Lot [1920,0,1920,2160] |
© 8 Signal Signal ; Signal 3 Signal : Signal 3 Signal’: Signal 3 ]
9 Signal !
(@) 10 Signal |
_______________________ L-
n Signal Mame : {3jMonitor Mame : {(4iMonitor |
12 Signal | Location : [0,540,960,540] | Location : [960,540,360,540]
Signal : Signal 3 Signal : Signal 3
13 Signal
14 Signal
15 Signal
] sona 1-3 R 1-4
__________ g / cRp—
~ / A

Figure 2.3-1 Configuration Window
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The buttons in tool bar and the menu items in menu bar are different
according to the contents in working area, the details are as follows.

2.3.1.1 Device Configuration Window

1—n’t Comfigers, Deax. Nalp
2— #0088

Click Device tab | DEVICE | at the top of the working area, it will display

the device configuration workplace, as shown in Figure 2.3-2. The device
configuration window is the default window when start up the software. It
Is used to set the alarm information, output format, serial parameters,
network information, timing and so on.

Aurors Bulti-image System Editor )
ge Sy =lalx

31 day

= DEVICE | SOURCE | VIDEO SALL | LAvouT | Vides Alsrm Config
¢ ] Klarm Config

o i lame Value

[ Video Alerm Config| Vvides Loss Enable [v]
[} aodio Mwm config

o ) Source 2

o= 5 Seures 3

Vides Freeze |

Vides Presze Semsitivity(%) |0 ...

o [ Somrce 4

o= = Souree 5 Vides Preeze Durationls) 80 —l...

o= Source & ) )
Video Black

o [ Seares 7 u

P | g
=

»1ides Black Sensitivity(®) FYIE|
o= ] Soarce § ':
o [ Source 10 Vides Bluck Duration(s) 60 l—
o= ] Seares 11 =
o ] Source 12
o= ) Soures 13
o [ Somrce 14
o= ] Seuree 15
&= Source 16
Dl}ntput Format
¢ ) Serial Fert List
[ rsazz
[ psass
[ rsass—
[} systea Config
(Y 150 config

# Osline IP: 192 168.1.70 I& ﬂik_‘ilgllg‘

Figure 2.3-2 Device Configuration Window

Configure the device in the device configuration window, the details are as
follows:

1. Menu Bar

It lists the commands used for device configuration.

File

Save M It is used to save the device configuration
changes.

It is used to import the monitor or model

Import & data.

18
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It is used to export the monitor or model
Sipat = data to the destination folder.
. It is used to shut down the Aurora
Exit - . .
multi-image system editor.
It is used to open the device connection
Connect - dialog box, select a device and connect to
it.
, p It is used to cut down the connection with
Disconnect & .
the current device.
Configure Refresh O It |s.us§d to relpad the current connected
device information.
Time Setting || @ It is used to timing the multi-image
processor manually.
Matrix @ It is used to configure the signal source
Configuration for the matrix output.
User ® .amin |/t IS Used to create and manage users
Management | * with various privileges.
Switch User |- It is used to switch to another user.
User - -
Update i It is used to modify the password of the
Password current user.
Sign Out - It is used to sign out from the current user.
Restore It is used to restore the factory default to
Factory - .
this software.
Default
. It is used to display the basic device
Device . )
) - information of the current connected
Information ..
multi-image processor.
It is used to switch an interface language
Help Language - for this software, selecting from Chinese
and English.
Change . L
N It is used to change the authorization
Authorization |- .
code to the multi-image processor.
Code
It contains Zip File and Update
Hardware - commands. The former is used to pack
Update i b

files, the latter is used to upgrade.
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It is used to display the basic and version
information about this software.

About... -

2. Tool Bar

It lists the shortcut commands used for device configuration, the
commands from left to right are save and connect.

F Connect

Picd Disconnect

| Save

® Matrix Configuration
dEh Import

££h Export

B Device Connect: refer to "2.2.2 Device Connection" for the
operation.

B User: There is a user shortcut button at the right side of the tool bar.
The current user name is displayed on this button, click this button to
display the drop down list of the user control, as shown in Figure 2.3-3,
select the command to execute the corresponding operation. Refer to
“3.1.1 User Management” for the details about user commands.

a

Uzer Management
e Svitch User
a Update Password
[= Sizn Out

Figure 2.3-3 User Commands List-Tool Bar

B Tips

¢ The function of the shortcut button in tool bar will not be described further
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more, for it has already been described in the corresponding menu
command in menu bar, the same as in source configuration, video wall

configuration and model configuration.

* Referto “3.1.1 User Management” for the details about user commands in
tool bar, the same as in source configuration, video wall configuration and

model configuration.

3. System pane for device configuration
It provides the system sources for device configuration.

It displays the device information as a tree diagram. The root is Aurora,
and the branches are: Alarm Config, Output Format, Serial Port List,
System Config and TSL Config, as shown in Figure 2.3-4.

Ij Aurora
9 ] Alarm Config
T |jS-:-urce 1
D |"|'1'.decu Alarm Config
|j| budio Alerm Config
o= |j Source
o= Ij Source
o= Ij Source
o |j Source
o= |j Source
o= Ij Source
o= Ij Source
o |j Source
o= Ij Source 10
o= Ij Source 11
o= Ij Source 12
o |j Source 13
o= Ij Source 14
o= Ij Source 15
o= Ij Source 16
D Output Format
9 [JSerial Port List
[y rs422
[ rsas5-1
[ rsass-2
D Swvstem Config
[ 15L Config

Ly I v o B I & ¥ ) BT C S S B )

Figure 2.3-4 Device Tree

4. Working area for device configuration
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It displays an illustration of device tree and other configurations.

5. Property pane for device configuration

It provides the property list for device configuration. Click the branch node
in the device tree, it will display the corresponding the property
parameters in this pane.

The parameters are shown in a table list, and you can expand or collapse
the parameters list by click the up and down arrow -/~ in property

pane.
B Display property parameter

The parameters are different according to the branch node.

For example: click to select the node " Source01"->"Video Alarm Config",
the video alarm list is as shown in Figure 2.3-5:

1 drora |('oevice | source | oo waL [ msvowr | i[Vides Alurm confic -~
¢ CJAlarn Config : P
¢ CJSsurce Hame Value
D ideo Alarm Config Video Loss Enable
T iadic Mlarm Confiz |
L] dudio orm LemiiE = Video Freeze I:l
o= ] Source 2 i
o= [ S0urce 3 2 Video Freeze Sensitivity(%) [0 %
o= [ Source 4 "
= [ Soures 5 Video Freeze Durationis) 60 =
o= 5 ] .
E source Video BElack O
o= [ Source 7
o [ Source 8 Video Black Senmsitivity(%) 24—
o= ] Source 9 N
o IjSource 10 Video Elack Duration(s) 60 =

Figure 2.3-5 Property Pane for Device Configuration

B Set the value for property parameter

There are property name, property value and its operation button in the
property list. Set the value according to the project need.

2.3.1.2 Signal Source Configuration Window

Click SOURCE tab | SOURCE | at the top of the working area, it will
display the signal source configuration workplace, as shown in Figure
2.3-6, it is used to modify the signal source name, create the mapping
relationship between the audio channel and the audio meter, configure
UMD and TALLY source.
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jumrars Bulti-issge Systes Editer =1o]x
P Configms i Halp
2—5 s
pevice | somce | viveo waL | Lwvow |
b | Sigeal Mams | hedis Mever 1| Radis Wemer 2 | kadis Mataw 3 | hoiis Miver 4 |TSL 31000 M TSL 5.0 Address B0 Typs 0 Taxt Seares Lafir Tally Seares Kight Tally sme.l
1 Seureedl Bab 12 ek I~ b 56 Eab (-8 128 o Dynemie seur ewll 5L 5L
3 2| Swwe | mbia tab 12 Wi | mhie | 129 o Eynami e | sewresid 5L TiL
+1 Searesdd Bab 12 tab 34 Wi | mhe | 128 o | searesttd L T
4 | Soureeld Bab 12 ab 34 teh 54 | Ish -8 Rl o Sravie | S el TSl L
B | Sereedd Bab 12 Tab 4 tmh 54 | Eah 8 | (e @ Stutic | vear il Tl it
] Searenld Esb 1% ¥ Eab 54 Eab 1§ ] o searcald L HL
4 1 T Toarcell! T Eab 12 e 34 E=h 5-€ [ Esb T8 I 28 o Static woareed’ L 118
8| Sewews | mabi2 w4 | mi5e | B | 128 ] Static | ] L 1L
£l | [ Eab 1-2 Eab 34 | Emh 56 Eb T8 [ 128 o Static [ rourceld msL I 118
10 | Eab 1-2 Eak 34 Emh 56 Emb T8 [ 128 o Static [ seurcatl msL [ L
u | Esb 12 Eab 34 Eab 56 s | 128 ] Sta | oarcatl 5L I T5L
12 Eab 12 | Eak 34 Emh 56 Enb -8 | 128 o Static | teurcal? | IsL | 5L
13 | Searceld [ Eab 12 | Eak 34 Emb 56 Enb -8 | 128 o Static | u | IsL | TsL
| Sewed | mbie Eak I~ Eab 56 s | 178 o Searie [ e 1 5L I T5L
15 | SeurealS | Eab 1-2 Eak 34 Emb 56 Eab -8 | 128 o Statie | seureals 5L | T5L
18 | Seurealf I Eab 12 Bk 34 Emb 56 b T8 I 128 o Starie | seurealf 5L I T5L
#F Delize TP 132163170 %"“ 'c,'@”s'

Figure 2.3-6 Source Configuration Window

Configure the source in the source configuration window, the details are
as follows:

1. Menu Bar

It lists the commands used for signal source configuration.

It is used to save the device configuration

SEWS B changes.

) It is used to import the monitor or model

Import data

File

B It is used to export the monitor or model

Export data to the destination folder.

It is used to shut down the Aurora

Exit i multi-image system editor.

It is used to open the device connection
Connect ¥ dialog box, select a device and connect
to it.

Disconnect - It is used to cut down the connection with
_ the current device.

It is used to reload the current connected
device information.

Configure Refresh O

It is used to timing the multi-image

Time Setting processor manually.

Matrix ® It is used to configure the signal source
Configuration for the matrix output.
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User e .amin |It 1S Used to create and manage users
Management | * with various privileges.
Switch User |- It is used to switch to another user.
User - -
Update i It is used to modify the password of the
Password current user.
. It is used to sign out from the current
Sign Out - uSer.
Eg;tgrre i It is used to restore the factory default to
Defaul¥ this software.
Device It is used to display the basic device
Information |~ information of the current connected
multi-image processor.
It is used to switch an interface language
Language - for this software, selecting from Chinese
Help and English.
,(A:Ste;]r(])griezation i It is used to change the authorization
Code code to the multi-image processor.
Hardware It contains Zip File and Update
Undate commands. The former is used to pack
P files, the latter is used to upgrade.
About i It is used to display the basic and version
information about this software.
2. Tool Bar

It lists the shortcut commands used for source configuration, the
command is save.

M Save

3. Working area for source configuration

The signal source information for each interface is listed in a table,
including ID, Signal Name, Audio Meter 1, Audio Meter 2, Audio Meter
3, Audio Meter 4, TSL3.1/4.0 Address, TSL5.0 Address, UMD Type,
UMD Text Source, Left Tally Source, and Right Tally Source, as shown
in Figure 2.3-8:
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DEVICE | SOURCE | VIDEQ FALL | Lavour |

ID | Signal Weme | hudio Meter 1 | Audio Meter 2 | hudio Meter 3 | Audio Meter 4 |ISL 3.1/4.0 Add .| TSL 5.0 Address UMD Type WD Text Source Left Tally Source |Right Tally Source

1 Sourcell Eab 12 Eab 34 Enb 56 Eab 78 128 0 Dynamic [ source 01 TSL TSL

2 Sourcel2 Eab 12 Eab 12 Enb 56 Eab 78 129 0 Dynamic [ source 02 TSL TSL

3 Sourceld Eab 12 Eab 34 Enb 56 Eab 78 128 0 St TSL TSL

4 Sourceld Eab 12 Eab 34 Enb 56 Eab 78 128 0 St TSL TSL

5 Sourcel5 Enb 12 Emb 34 Enb 56 Fab 78 128 0 S TSL TSL

6 Source08 Enb 12 Emb 34 Enb 56 Fab 78 128 0 S TSL TSL
Source0? Enb 12 Emb 34 Enb 56 Eab 78 128 0 S TSL TSL

8 Source08 Enb 12 Emb 34 Enb 56 Eab 78 128 0 Static | sowrece 08 TSL TSL

Figure 2.3-7 Signal Information for Source Configuration

Refer to for "3.3 Source Configuration” the details.

2.3.1.3 Video Wall Configuration Window

Click VIDEO WALL tab r“DEﬂ WALL | at the top of the working area, it will

display the video wall configuration workplace, as shown in Figure 2.3-8,
it is used to configure the video wall.

1 nrors Nulti-image Syztem Editer =10 x|
Fils Configwrs User Halp

2—nim - L

— e

] Gutput [ DEVICE | SOURCE [ VIDEO WALL | LAvOUT Tall Properties ~
Dﬂntput -1 4 F I
D’Dntput 1-2 4 S

3 —_—

Dﬂ'utput 14

& Online IP: 152.168.1.70 EEE

Figure 2.3-8 Video Wall Configuration Window

Configure the video wall in the video wall configuration window, the details
are as follows:

1. Menu Bar

It lists the commands used for video wall configuration.

File New 0O It is used to create a monitor.
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)

o — It is used to select and open an existed
pen — .
monitor.
Save [ It is used to save the configuration changes
to the current edited monitor.
- It is used to close the current monitor window
Close | . ;
in working area.
It is used to delete the current monitor
Delete () : : .
window in working area.
Import £y It is used to import the monitor or model data.
Export B It is used to export the monitor or model data
P to the destination folder.
. It is used to shut down the Aurora
Exit - - X
multi-image system editor.
Connect P It is used to open the device connection
dialog box, select a device and connect to it.
Di p It is used to cut down the connection with the
isconnect & :
current device.
Configure | Refresh O It is us_ed to r_eload the current connected
device information.
Time Setting o It is used to timing the multi-image processor
manually.
Matrix It is used to configure the signal source for
; . @® .
Configuration the matrix output.
User ® dmin It is used to create and manage users with
Management | * various privileges.
Switch User |- It is used to switch to another user.
User - -
Update ) It is used to modify the password of the
Password current user.
Sign Out - It is used to sign out from the current user.
Restore It is used to restore the factory default to this
Factory -
software.
Default
Help : : : :
. It is used to display the basic device
Device . )
: - information of the current connected
Information

multi-image processor.
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It is used to switch an interface language for
Language - this software, selecting from Chinese and
English.
Changg . It is used to change the authorization code to
Authorization |- -
the multi-image processor.
Code
It contains Zip File and Update commands.
Hardware : . .
- The former is used to pack files, the latter is
Update
used to upgrade.
About i It is used to display the basic and version
information about this software.
2. Tool Bar

It lists the shortcut commands used for monitor configuration, the
commands from left to right are: New, Open, Close, Save, Delete,
Open/Close Monitor Label.

0O New | Save
= Open () Delete
| Close Monitor Label

B Monitor Label

Click this button to display or hide the monitor label. The monitor label is
as shown in Figure 2.3-9, it is displayed a black rectangle at the center of
a monitor, labeled its output interface number. For example, if the output
for the monitor is OUTOUT1, the label is "1-1 wall", it represents the first
output interface of the first output module.
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Figure 2.3-9 Monitor Label

B Tips

e Monitor label is used during the monitor assembly. Display the monitor

label, and you could locate the monitor quickly.

3. System pane for monitor configuration

It provides the sources for monitor configuration, as shown in Figure
2.3-10:

|j Output

D Output 1-1
B Output 1-2
D Output 1-3
B Output 1—4

Figure 2.3-10 System Pane for Monitor Configuration

O Output: It provides the available output interfaces for the monitors.
Click and drag an output interface from the output list in system
pane to a target monitor in working area, thus to establish the one
to one relationship, as shown in Figure 2.3-11:
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(1 Output DEVICE | SOURCE | VIDEOWALL | LAYOUT

{ovpur117]
[y Output 1-2
[y Output 1-3
[y Output 1-4

Figure 2.3-11 Output Interface for a Monitor Panel

B Tips

* Do the refresh operation to reload the output interfaces when the device

has been changed.

4. Working area for monitor configuration

It displays the video wall editing area. When you have created a few
monitors, the opened monitors will be displayed as tabs at the bottom area
in working area. Click the tab to switch it as the current editable monitor,
as shown in Figure 2.3-12:

DEVICE | SOURCE | VIDEOWALL | LAYOUT

WallD1 | Wallo2*

Figure 2.3-12 Working Area for Monitor Configuration

B Tips

e Limitation for wall amounts: for an AURORA1600 1U device, there is only
one wall allowed, but for an AURORA9600 9U device, there could be
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multiple walls.

* Scroll the mouse wheel up or down when the mouse cursor in the working
area of monitor configuration, it will zoom in or zoom out the display area

convenient for checking, as shown in Figure 2.3-13:

ZOOMIN

Figure 2.3-13 Zoom In and Zoom Out the Working Area for Monitor
Configuration

5. Property pane for monitor configuration

It provides the property list for monitor configuration. It displays the
monitor property parameters in this pane, including Name, Horizontal
Monitor Number, Vertical Monitor Number, Horizontal Gap, Vertical
Gap, and Audio Output Card, as shown in Figure 2.3-14:

Wall Properties -~

Propertw Value

Hame TV Wall

Horizontal Screen Number |2

Vertical Screen Number 2

Horizontal Gap 0

Vertical Gap 0

fudie Output Card

Figure 2.3-14 Property Pane for Monitor Configuration

Refer to "3.4 Video Wall Configuration " for details.
2.3.1.4 Model Configuration Window

Click LAYOUT WALL tab rlﬁ"fﬂUT at the top of the working area, it will
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display the model configuration workplace, as shown in Figure 2.3-15, it is

used to configure the model.

1 Ednurora Walti-image Systes Editor

File Edit Vier Tools Elwments Confipwe User Help

2 DamE@ B0 528 [

% s

& [Qlfpue  [r]al=][e] [+ 2

Sigasl List
3— It Enpde Souwrce List
[ seueen
[ sourcetz
[} Seurcets
4 m
Prevarres
[ seurcets
[} seueens
D) sewcent
5 [ -
=]
D sourcete
D) sourcaro
[ sowrcerr
[ seurcer2
D) seuwears
D) sewrcers
D) seuwcets
) seueats

& Osline IP: 192.168.1.70

Templates | DEVICE | SOURCE

L= = e i 2

I Fall0l-Layout0l [

[ vipeo waLL | avonT |

“Element Frop | Medel Prep |

Mani ter ~

Froperty | Value

Meniter Hame Meoni tor

Aspect Ratio 16:9 =

Source Aspect Ratic Feserved | ¥||...

—

Starting T-Coordinate (150

Wideh 950

Hei ght Geed

WO Display Meds Outside. .. | ¥
View

Proparty ] Valus

Main Findew

1225 , 100 Video Format Enabled ] hed|

tlla[e o]0

Figure 2.3-15 Layout Configuration Window

Configure the model in the layout configuration window, the details are as

follows:

1. Menu Bar

It lists the commands used for model configuration.

File

New 0O It is used to create a model.
Open - It is used to select and open an existed
model.
Save ) It is used to save the configuration changes
to the current edited model.
Save Al = It is used to save the ponflgu_ratlon changes
to all models opened in working area.
- It is used to close the current model window
Close | : i
in working area.
It is used to delete the current model
Delete L , : .
window in working area.
Import It is used to import the monitor or model
data.
Export ) It is used to export the monitor or model
P — data to the destination folder.
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Exit i It is used to shut down the Aurora
multi-image system editor.
Undo L2 It is used to cancel the recent operation.
Redo It is used to restore the latest undo
operation.
Cut It is used to cut the selected components to
the clipboard.
It is used to copy the selected components
I .
cepy L to the clipboard.
Paste C It is used to copy the components recorded
Edit _ lastly in the clipboard to the working area.
Delete o It is used to delete the current selected
il components in working area.
Clear I It is used to delete all the components in
__ current model in working area.
Select All i It is used to select all the components in
current model in working area.
It is used to cancel the selection of all
Select None |- components in current model in working
area.
Zoom In Q It is used to zoom in the display area of the
monitor in working area.
Z00m Out Q It is used to zoom out the display area of
the monitor in working area.
Fitting  With - It is used to zoom the display area of the
Screen - monitor to fitting with screen.
It is used to control the display ration of the
Ratio Custom |« [Imonitor, providing these ratios: 50%, 75%,
View 100%, 125%, 150%, 250%, 300%.
It is used to set whether to enable the
docking function. When enable docking,
: you will be easy to resize the element
DEEnE ¢ window to align to the grid line, there will be
a red guideline docking to the nearest grid
line.
It is used to enable/disable to highlight the
ﬁ]?g;’rvna?g:]pm T output interface information and the brim of
the display screens on the layout editing
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Tools

area.
g%% Size It is used to copy the size of the current
selected element window to the next
Selected
: selected one.
Monitor
Copy
Properties It is used to copy the properties of the
From - current selected element window to the
Selected next selected one.
Monitor
It will divide the current selected monitor
) . — window into desired parts according to the
Sl | ratio. Usually cooperated with the magic
wand tool.
Expand It will make the current selected monitor
ba e window to be magnified and aligned to the
Monitor Lo
nearest grid line.
. — It is used to align all selected element
Align Left e .
windows to the leftmost one.
. . — It is used to align all selected element
Align Right — windows to the rightmost one.
. It is used to align all selected element
i ;
Al T I windows to the topmost one.
Alian Bottorn I It is used to align all selected element
9 LU windows to the bottommost one.
: . It is used to align all selected element
Align Vertical |[ = . .
— windows to the average vertical center of
Center ;
these windows.
Align It is used to align all selected element
Horizontal 11} windows to the average horizontal center of
Center these windows.
It is used to remove the gap among all
selected element windows in horizontal
. direction.
Horlz_ontal [++] The reference point is the top left corner of
Docking :
the leftmost window among all selected
element windows, they will line next to each
other in horizontal direction.
Vertical T It is used to remove the gap among all
Docking = selected element windows in vertical
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direction.

The reference point is the top left corner of
the leftmost window among all selected
element windows, they will line next to each
other in horizontal direction.

It is used to reallocate the horizontal

Horizontal . X
Equal m distance .between every two center points
; of the adjacent selected elements to be the
Spacing
same.

. It is used to reallocate the vertical distance
Vertical Equal |[ b . F th
Spacing = etween every two center points of the

adjacent selected elements to be the same.
It is used to redistribute the width of all
Equal Width || |+ selected element windows to the average
width of these windows.
It is used to redistribute the height of all
Equal Height || I selected element windows to the average
height of these windows.
Select 3 It is used to select an element window.
Monitor (| It is used to add a monitor element.
Analog Clock || € It is used to add an analog clock element.
Elements . . -
Digital Clock || [5 It is used to add a digital clock element.
Date = It is used to add a date element.
It is used to add a big enough monitor
Magic Wand || z¢ window to full fill the blank where you have
clicked the mouse.
It is used to open the device connection
Connect r 4 dialog box, select a device and connect to
it.
. - It is used to cut down the connection with
Disconnect & :
Configure the current device.
Refresh O It is usgd to re_Ioad the current connected
device information.
Time Setting || ® It is used to timing the multi-image

processor manually.
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Matrix @® It is used to configure the signal source for
Configuration the matrix output.
. It is used to rearrange the created models
Layout Editor || #] in model list.
gmtgr‘]t oS It is used to apply the current layout to the
Layout * connected device.
User ® .qmin |t IS Used to create and manage users with
Management | * various privileges.
Switch User |- It is used to switch to another user.
User - -
Update i It is used to modify the password of the
Password current user.
Sign Out - It is used to sign out from the current user.
Essttgrre i It is used to restore the factory default to
Defau|¥ this software.
Device It is used to display the basic device
Information |~ information of the current connected
multi-image processor.
It is used to switch an interface language
Language - for this software, selecting from Chinese
Help and English.
gzﬁlr:)%?zation i It is used to change the authorization code
Code to the multi-image processor.
Hardware It contains Zip File and Update commands.
Undate - The former is used to pack files, the latter is
P used to upgrade.
About i It is used to display the basic and version
information about this software.
2. Tool Bar

It lists the shortcut commands used for model configuration, the
commands from left to right are: New, Open, Close and so on.
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0O New Layout 3 Cut
= Open Layout g Copy
Close Current
] Paste
— Layout &
™ Save Layout g} Remove
y i Elements
i Save All Layouts || m Clear Layout
Delete  Current
Zoom In
x Layout Q
o Display Current e Ratio
= Layout
Layout Sorting&
o z Out
o] Switching Q oom 2
o Full Screen i Fit Screen
L Undo & Snap
~ Redo T Show | Output
Information

3. System pane for model configuration

It provides the Sources and Templates for model configuration, as shown
in Figure 2.3-16:
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O

l/ﬂign.al List Templates

[ Input Source List
|j| Soureell
D Sourcel2
|j| Sourcel3
D Sour celd
|j| Sourcels
D Sour celd
|j| Sourceld?
D Sour celd
|j| Sourceld
D Sourcell

|j| Sourcell

D Sourcel2

|j| Sourcelld

D Sourceld

|j| Sourceld

D Sourceld

Figure 2.3-16 System Pane for Layout Configuration

Input Source List: It provides the available signal sources for the
monitor elements. Click and drag a signal source from the sources
list in system pane to a target monitor element in working area,
thus to establish the one to one relationship, as shown in Figure
2.3-17:

[fﬂignal List [ Templates | | 'DEVICE | SOURCE | VIDEO WALL [ LAWOUT |

“j Input Source List * | @ & | 5 ﬁ =I_| ==

[} Bourceon

|j| Sourcel2
|j| Sourcel3
|j| Sourceld
|j| Sourceld
|j| Sourcels
|j| Sourcel?

|j| Sourceld

Figure 2.3-17 Signal Source for a Monitor Element

O Templates: It provide some templates in the Templates pane,

including default templates and customized templates, as shown in
Figure 2.3-18:
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S1gnal List Templates

Cuztom e

Default .

Templ atel2

@

Templ ate0l

Figure 2.3-18 Templates for a Layout

4. Working area for model configuration

It provides a workplace for adding, arranging and editing all element
windows for model layout.

[‘DEvICE | source | vIDEO WALL | LAYOUT |

hojeea =7 ==::

Talldl-Layout0l

Figure 2.3-19 Working Area for Model Configuration

When you have created a few models, the opened models will be display
as tabs at the bottom area in working area. Click the tab to switch it as the
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current editable model.

O Arrange tools: it provides various elements and align tools for
arranging the model layout.

k Select = Align Right

- Monitor Il Align Top

L\ Analog Clock i Align Bottom

& Digital Clock - Align Vertical Center
B Date i éltia?]rt]er Horizontal
> Magic Wand |+ Horizontal Docking

Copy Size From

Selected Monitor + Vertical\Pocking
= Copy Properties From m Horizontal Equal
Selected Monitor Spacing
. . : Vertical Equal
(1] ——
an Split Monitor == Spacing
e Expand Window T Equal Width
= Align Left o] Equal Height

5. Property pane for model configuration

It provides the property list for model properties and element properties.
Modify the value for a property, click Enter key to confirm modification,
and click save command to save the changes.

O Model Properties: Show the properties list for the current model.

O Element Properties: Show the properties list for the selected
element, as shown in Figure 2.3-20:
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[rEleme:nt Prop rHodel Prop

Moni tox ~
s
Appearance s —
Property Value
Monitor Wame Moni tox 5
Aszpect Ratio 16:9 | . ..
Source Aspect Ratio |Reserved w . .. 1

Starting {Coordinate|l

Starting YCoordinate|l

Width 960
Hei ght 540
IMD Diszplay Mode Inzide Monitoxr | |[|...

View ~

Figure 2.3-20 Properties Pane for Model Configuration

B Tips

* The parameters list in elements properties pane are different according the
type of the selected element in working area.

2.3.2 Offline Editor

The offline editor is used to edit offline.

1. Enter offline editor

Click the “Enable offline editor” button| e | in the right bottom of the
status bar to enter the offline editor.

The offline editor must be used under the offline status. If the device is in
online status, it will prompt to cut down the connection with the current

device.
x|
? Enable 0ffline Editor w1ll discard all unsaved settings, confirm?

0K Cancel

Figure 2.3-21 Prompt for Entering Offline Editor
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First, save the modification to the current connected device, then click
Disconnect button| ¥ | in tool bar, or select the

“Configure>Disconnect” command in menu bar, thus to disconnect with
the current device, and there is Offline keyword in the left bottom of the
status bar.

Click the “Enable offline editor” button| e | to enter the offline editor. It
will pop up the data selecting dialog box, as shown in Figure 2.3-22, click
New button [N or Import button & to select the target data.

Please choose the need to edit the data E

| =

=

Figure 2.3-22 Select the Editing Data

H New

Click New button IR , it will prompt the new dialog box, as shown in Figure

2.3-23, selecting Auroral600 or Aurora9600, click OK button to confirm
the new operation, and it will load the offline editor interface.

Flease choose the need to e 2ﬂ

i®) Aurora 1600 ) Aurora 9600

0K Quit

Figure 2.3-23 Select the Editing Data

If selecting Auroral600, it will display an illustration for Auroral600 at the
working area of Device configuration window, as shown in Figure 2.3-24,
and the input components of this device will be displayed in the system
pane at the left area of the offline editor window.
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Au.rora Bulti-image System Editor [offline editor] _|E||5|

File Configure User Help

| @ &) &

[ durora | oEvice | source | 'vipo warL | ravour |

o= Ij Alarm Config
D Output Format

L ﬁSerial Port List
D Svstem Config
[ 1SL Config

e 0Ffline Edit
(54

Figure 2.3-24 Offline Editor-Auroral600

You can see the keyword Offline Edit and its icon B in the status bar at the

bottom of the window.

If selecting Aurora9600, it will pop up the Device Configuration window for
Aurora9600, as shown in Figure 2.3-25. The window provides an intuitional
illustration for configuring input module and output module for Aurora9600.
Please assign the module type from the selection drop down list in each
selected module slot according to your actual requirements.

The module positions of Aurora9600 are consistent with the actual positions.
For example: click the down arrow of No.1 Input module to assign its module
type to be SDI or None, as shown in Figure 2.3-26, click OK button at the right
bottom of the window to confirm the assignment.
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x|
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Figure 2.3-25 Device Configure-Aurora9600
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[12. Input s [~]]
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[16. Input s [~]]
17. Input ST |
[t [ [7]] - vt [~
[18. Imput [sor T[] I I

Figure 2.3-26 Set Device Type-Aurora9600

As shown in Figure 2.3-27, it displays the offline editor interface of
AURORA9600. The input sources below the Alarm Config node are
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displayed at the system pane. The source name is as the format of
“Source”+’Module Slot number” +”.”+ "Interface number”, each input
module contains 8 input interfaces, and each output module contains 4

output interfaces.

Aurora Bulti-image System Editor [offline editor] _IDILI
File Configure User Help
[ ]
rird =) 2
[ furora |(‘oevece | source | vineo waL | Lavowr |
¢ £ Alarm Config £
LS Ij[nput 1
o= [ Source 1.1
o IjSource 1.2
o= 3 Source 1.3
o= IjSource 1.4
[ Sewee 1.5 : = = g
| || e[ [ T |
o= 50urce 1.6 i CE Tt ST 01. Output 1
o= Source 1.7 i 1 :
§ [0 Tnput 80T |
o= 5ource 1.8 £ i T ] 02. Output
& [ Ingu 2 || || CE—mme—sm
o ] Input 4 1 s e
& tepu - E: 04. Output
o [ Input 5 i (08  Tnput 80T |
§ (08  Tnput 80T |
IS lj Input & E; 03, Output
o [ Input 7 : (10 Tnput  SOT |
: [O1 " Taput  SOT |
o= --
Ij Input 3 : T2 Topur—sor | Wi $13 08, Output
& E Tnput 8 | || e
& [ Ingut 10 || ||
& [ Tnput 11 11 e
o o 2 == o
- | | =
& [ Input 14 : (18 Tnput 807 || LIL
& [ Input 16 Ao Contral Hodule | e
o= Ij Input 17 :
o Ij Input 13
D Output Format
=[] 5erial Fort List
[ system Config
[y 15L Config

G ottine i (@[]
L+

Figure 2.3-27 Offline Editor -Aurora9600

The other operations are the same as in online editor, please refer to the
following descriptions, it will not descript in this section further more.

B [Import

Click Import button o | it will prompt the new dialog box, as shown in
Figure 2.3-28, press Browse button to import the backup data.
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Import [<]

Select Fle: | H Browse... |

Figure 2.3-28 Import the File Data

After entering the offline editor, the operations in offline aurora control
software are as the same as in online mode.

2. Exit Offline Editor

Click the “Exit the offline editor” button| %L, | in the right bottom of the status

bar to quit from the offline editor. It will prompt for exporting the offline data,
as shown in Figure 2.3-29, click OK to save the data.

x|

? Please he sure to export the offline data, in order to avoid missing, confirm the exit?

| oK || Cancel |

Figure 2.3-29 Prompt for Exiting the Offline Editor

First, save the modification to the current device, and then click Export
button in tool bar, or select the “File>Export” command in menu bar,

thus to export the project data to a data file.

Then, you can connect the device to be online again and enter the online
mode.

B Tips

* The operations in offline editor of aurora control software are as the same

as in online mode, you can refer to the following chapter, there will be no

descriptions in this section further more.
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2.3.3 Online Control Editor

The online control editor is mainly used to observe, preview and switch the
online display content, and you can switch on or off the alarm, display or hide
the markers, or selecting a desired audio to be output.

1. Enter online control editor

Click Control| | button in the right bottom of the status bar to enter the

online control editor. It will prompt a dialog box, as shown in Figure
2.3-30,click OK to confirm entering Aurora Multi-image System Controller,
as shown in Figure 2.3-31:

Tip

?

Sure to continue enter Auroras Muti—image System Controller?

0K Cancel

Figure 2.3-30 Prompt for Entering the Online Controller

[EdAurora Bulti-image System Contreller

[J?

.
# Online - 192.168.1. 70
Figure 2.3-31 Online Controller

2. Exit online control editor

Click the “Control” button| 5 | in the right bottom of the status bar at the

Online Controller interface to exit the online control editor, it will prompt as
shown in Figure 2.3-32:
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Tip

H Confirm to g0 to editor system?

0K Cancel

Figure 2.3-32 Prompt for Exit the Online Controller

Click OK button to exit from the online controller, it will be back to the
Configuration editor.

Refer to “3.7 Online Control” for the details about Online Controller.
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Chapter 3 Functionalities and Operations

This chapter is used to introduce the functionalities and operations in Aurora
multi-image system editor.

3.1 Basic Function

3.1.1 User Management

The User menu contains the following commands: User Management,
Switch User, Update Password and Sign Out. Click User menu in the
menu bar, or click the User shortcut button at the right side of the tool bar
to activate the corresponding user command, as shown in Figure 3.1-1.
The current user name is displayed at the top position of the User menu
list, and on the User shortcut button.

Uzer | —
[ ]
. [ ]
[}

B Uzer Management
e Switch User

a Update Password
[ sizn Out

e Switch User
a Update Password
[= S1gn Out

Menu Bar Tool Bar

Figure 3.1-1 User Commands

1. User Management

The system contains two levels of operating rights according to the
operating requirements, the privileges of these accounts:

B Administrator: it has the entire operating rights.

B Common: it has only the basic operating rights without modification
right.

Create several accounts by User Management command, and the
privileges of these accounts are different according to their levels, thus to
be convenient for different levels of operators.

Operation: select User Management command, it will pop up the User
Management window, as shown in Figure 3.1-2:
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1
'

User HManagement

User name

User Type

X

Delete

admin

Administrator

123

Operator

Delete

|| Create ‘

Figure 3.1-2 User Management Window

The users list in the User Management window displays User name and
User Type information. Input a new user name and the corresponding

user password at the bottom field of the window, and click Create button
to add a new user to the list above.

B Tips

*  Only the user with the administrator level can create new users.

2.  Switch User

Select User Login command, it will pop up the User Login window, as

shown in Figure 3.1-3:

]Iser Login

X

aﬂmin

Remember me

Logzin

Figure 3.1-3 User Login Window
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B Switch user: it is used to switch to another user. Click the down arrow
in the field of user name, it will show the user name list. Select the user
which you want to login in.

B |nput password: input the password matched with your selected user,
then press Login button. If the password matches the user, you will
login in successfully, otherwise, if they are mismatched, it will pop up a
prompt, as shown in Figure 3.1-4, press OK button, and re-input your
password.

x

P
|.\1/J Your passwnrd 15 not correct

0K

Figure 3.1-4 Prompt for Input Error Password

Tick off the “Remember me” selection, then you don’t need to input your
password next time.

B Tips

* The two default accounts are “admin” and “123”, the former is a user of

administrator privilege, the latter is a user of common level, their
passwords are both “123456”. The default “admin” account should not be
deleted.

3. Update Password

Set password for your user to sign in, and you could modify the password
to be a new one.

Operation: Select Update Password command, it will pop up the Update
Password window, as shown in Figure 3.1-5:
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Update Paszword EI

User name: admin

01d PassWord:

Hew PassWord:

[1)4

Figure 3.1-5 Update Password

At first, input the old password in the field of Old PassWord, then input
the new password in the field of New PassWord, then click OK button to

confirm the modification, it will pop up a successful prompt , as shown in
Figure 3.1-6:

x

@ User. update0E

0K

Figure 3.1-6 Update Password Successfully

B Tips

Only the account itself can modify its own password.

4. Sign Out

Use the Sign Out command to quit from the current account.

Select Sign Out command, it will prompt the User Login window, as
shown in Figure 3.1-7, you can choose another account to re-sign in.
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x

Femember me

Login

Figure 3.1-7 Sign Out

Select a user name, and input the correct password, click Login button to
sign in.

B Tips

* Switch to a different account by the User Login window.

3.1.2 Network Setting

Network setting is used to appoint the network parameters for setting up
the connection.

B Operation

Step 1 Connect a Device

Select "Configure"-=>"Connect" command in menu bar, or click connect
button| 2= | in tool bar, it will pop up the Device Connect dialog box. Input

the target IP address in IP field, as shown in Figure 3.1-8. Click Add
button to add this device, and then click Connect button to establish
connection with it.
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5
| Search Devices | | Network Card | IF:
| Device Hame IP Address Subnet Mask Gateway Device Type
[ ] |dur ara 182.168.1. 70 255, 2050, 200. 0 192.168. 1.1 A ox al 600

Figure 3.1-8 Connection Dialog Box for Device Connection

Step 2 Modify IP Address

Select "DEVICE"->"System Config" node in the working area of device
configuration, the parameters about the device network are listed in its
property pane, as shown in Figure 3.1-9:

Aurora Bulti-image System Editor _Iﬂlﬂ
File Configure User Help
[ ]
EEOERAE 2
[ Aurora |(‘vEvice | source | vipeo waL | Lavour | (ST e ~
o= ] Mlarm Config i i
i i Name Value
D Output Format 5 i
o~ [JSerial Port List : i|  Device Neme  [Murora
: :
: A | 1p rddress 192.168.1. 76
| § T5L Config : :
| | Subnet Mask 235,255, 255. 0
Gateway 192.168.1.1
T3
l e Languags fijaihed |'
E = &)
Mute ||
Volume ﬁ
# Online IP: 192.168.1.70

Figure 3.1-9 Modify IP Address

The parameters in its property pane are: IP Address, Subnet Mask and
Gateway, click the save button or save command in File menu after you

have modified these parameters. Then click Refresh button to reconnect
the device.

B Tips
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Rename the device in Device Name field in the property pane of
"DEVICE"->"System Config" node.

3.1.3 Window Switch

3.1.3.1 Switch Between Online Window and Offline Window

The Aurora multi-image system editor provides two kinds of interfaces:
Online Window and Offline Window. It will introduce how to switch
between them.

1. Online Window - Offline Window: click the “Enable offline editor”

o

button

in the right bottom of the status bar to enter the offline editor.

2. Offline Window = Online Window: click the “Exit the offline editor”
W,

button
editor.

in the right bottom of the status bar to quit from the offline

3.1.3.2 Internal Switch in Configuration Window

There are four configuration windows in Configuration window: Device
configuration, Source configuration, Monitor configuration and Model
configuration, the contents are different.

Click the configuration window tab to switch among these configuration
windows, and the auxiliary pane for the corresponding configuration
window are also changed.

For example: Switch from model configuration window to device
configuration window, the operation instructions are as below:

The current window is model configuration window, click the DEVICE tab
in the top of working area, thus switching to device configuration window,
as shown in Figure 3.1-10:
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lurora HEulti-image System Editor

=[0f x|
File Edit Vies Tools Elementz Configure User Help
frcten [
[Signal List | Templates | :[(DEvice | source | viveo sars || Lavour || Fnodel Frop |
[ Input Seurce List - | * || D” 0" || E || jlley Element Prop |
D Sourcell ; -~ Properties ~

1l :
.l.urora Bulti—image System Editor _Iﬂlﬂ
File Configure User Help

FAEdSIC Y

Ij Aurora ]

= (Jhlen Config]
D Output Format

0= ] Serial Fort List
D System Config
[y 1S Config

[
-

pevice ||source | vipeo warL | ravour |

Figure 3.1-10 Switch from Model Configuration to Device Configuration

The switch operation between the other windows are the same, refer to
"2.3 Software Interface" for the details about each window.

3.2 Device Configuration

The device information of the multi-image processor connected currently
are displayed in device configuration window.

1. Device Tree
Click DEVICR tab in the top of working area, it will display the device tree

in working area, as shown in Figure 3.2-1, it includes the following
devices information:
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Aurora Bulti-image System Editor _Iﬂlﬂ
File Configure User Help

ZAESICIY 2

[ surors |(‘vEvicE | source | vipeo warL | Lavour |
¢ CIMem config] |
o= IjSource':Il
o= IjSource':lQ
0= IjSource 3
o= IjSource 4
o= IjSource 5
0= IjSource ]
o= IjSource 7
o= IjSource 8
L IjSou.rce 9
o= IjSource 10
o= IjSource 11
L IjSou.rce 12
o= IjSource 13
o= IjSource 14
L IjSou.rce 15
o= IjSource 18
D Output Format
@[] Serial Port List
[y rsaz2
[} rsass—1
[ rsas5-2
D Swstem Config
[y 5L Config

’ Online IP: 192.163.1.70

Figure 3.2-1 Device Tree

B Alarm Config
B Output Format
B Serial Port List
B System Config
B TSL Config

Double click the device node in device tree, it will expand or collapse the
details, as shown in Figure 3.2-2. Double click each node to display the
corresponding parameters in property pane.
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[hurors Bulti-image System Editor =10l x|
File Configure User Help
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[ hurora |(vevIcE | source | vipeo waLL | Lavour | Video Alarn Config ~
? Clalarm Config :
4 Ol y Name Value
[y Videa Alarm Config Video Loss Enable
1 Audio Al Conf1
L1 Audio Alarn Config Video Freeze O
o= ] Sowrce02
o [ Sowee 3 Video Freeze Sensitivity(%) [0 -
=[] Sowrce 4 "
o [T Sowce 5 Video Freeze Duration(s) |60 =
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] Souree Video Black (|
o= ] Sowrce T
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D Output Format

0= [JSerial Port List

D System Config
[y 5L Config

’ Online IP: 182.168.1.70

] [a]l0][o]6]

Figure 3.2-2 Property Pane for Device Configuration

2. Alarm Config

Double click each input module node in device tree, it will expand the

interfaces including in this module. Each input module contains 8

interfaces, the No.1 input module contains Signall to Signal8 interfaces,
and the No.2 input module contains Signal9 to Signall6 interfaces, as
shown in Figure 3.2-3, and each interface contains two sub-nodes: Video
Alarm Config and Audio Alarm Config.

[ Aurora

o ] Alarm Config
o= ] Signal 1
o= [] Signal 2
o= Signal 3
o= Signal 4
o= [] Signal 5
o= [] Signal &
o= Signal 7
o= [ Signal 8
o= [ Signal 9
o= [ Signal 10
o= ] Signal 11
o= [ Signal 12
o= [] Signal 13
o= ] Signal 14
o= ] Signal 15
o= [ Signal 16

Figure 3.2-3 Alarm Config
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The default name for each interface is "Signal'+ "Interface number”, the
name of the interface is the same as the signal source's. Particularly,
when you modify the name of the signal source in source configuration
window, the interface name is changed synchronously.

3. Apply to All

There are Apply to All buttons| - | in the last column in Video Alarm and

Audio Alarm property panes. Click this button, and the value setting in the
former column will apply to the same property of all the other interfaces.

Video Alerm Config o~
Hame Value
Video Loss Enahble :|
Video Freeze L] 'IA:l'Jl}r To ﬂll
Video Freeze Sensitivity(%) [0 :—
Video Freeze Duration(s) 50 :—
Video Black D
Videa Black Sensitivity(%) 24:—
Video Black Duration(s) IE':I :—

Figure 3.2-4 Apply to All Buttons

4. Save the device configuration

Click the save button in tool bar, or select the save command in file menu,
it will confirm the saving for the device properties changes.

It will introduce the sub-nodes in device tree as below.
B Tips

* For AURORA1600 1U, the signal name is as the format of

“Signal”+”Interface number”.

* For AURORA9600 9U, the signal name is as the format of “Signal’+”Slot

Interface number”

3.2.1 Alarm Setting

1. Video alarm and audio alarm
The alarm is divided into video alarm and audio alarm according to the
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alarm contents.

B Video Alarm: supports video loss, video freeze and video black.
B Audio Alarm: supports audio loss, audio high and audio low.

Each input interface has video alarm and audio alarm, and when the value
of the alarm parameter meets the alarm condition, it will generate the
alarm event.

2. Alarm Switch

The alarm switch is divided into alarm action switch and alarm display
switch according to the alarm function. The former is used to decide
whether to detect the alarm that has happen or not, the latter is used to
decide whether the alarm information will be display or not. The
differences are as below:

(1) Alarm Action Switch

The alarm action switch is used to set whether the multi-image processor
processes and collects the selected alarm or not. If the settings are
positive, it will process and collect the alarm information of the selected
alarm event, then record the alarm data, otherwise, if the settings are
negative, or it will not process and collect the alarm information, and there
will be no alarm data.

In device configuration window, click the Video Alarm Config/ Audio
Alarm Config node to display the corresponding properties in the
property pane.

B Setting for Alarm Action Switch

Click "Interface of Input node"->Video Alarm Config/ Audio Alarm
Config in Device page, the property pane is as shown in Figure 3.2-5:

Video Alarm Config s budio Mlarm Config ~

Name Value Name Value

I Video Loss Enahle I Audio Loss Enable budio Channel Config
I Video Freeze I Audio High Threshold(dB) |-1

Video Freeze SEI‘[SitiTit}'(oﬂj 0 :— Audio High Turationis) 1 :—
Video Freeze Duration(s) 60 :— budio Low Thresheld(dE) |50 :—
Video Black budio Low Duration(s) &0 :—
Video Black Sensitivity(%) 24:—
Video Black DIurationis) &0 :—

Figure 3.2-5 Alarm Switches

You can see the alarm action switches for video alarm and audio alarm as
shown in Table 3.2-1.
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B Setting for Alarm Action Parameters

Click "Interface of Input node">Video Alarm Config/ Audio Alarm
Config in Device page, the parameters for video alarm is as shown in
Figure 3.2-6, and the parameters for video alarm is as shown in Figure

[ Aurora [ DEVICE | SOURCE | VIDEOWALL | LAYOUT | | yideo Alarm Config —
¢ 3 Alarm Config i §
¢ [ Signal 1 : : MName Value
[ Video Alarm Config 1 video Loss Enable -
Audio Alarm Config | & :
o [ Signal 2 Video Freeze .
o [ Signal 3 : E o =
o [ Signal 4 ;. Video Freeze Sensitivity(%) 0| -
o~ [] Signal 5 : 4 video Freeze Duration(s) 60| ..
o [ Signal 6 i :
o [ Signal 7 4 Video Black .
o [ Signal & i I o =
o [ Signal 9 I : Video Black Sensitivity(%) 24— .
o~ [ Signal 10 =1} video Black Duration(s) 60— ..
o= 3 Signal 11 :
Figure 3.2-6 Video Alarm Parameters
=7 Aurora | DEVICE | SOURCE | VIDEOWALL | LAYOUT | || Audio Alarm Config =
¢ [ Alarm Config :
¢ [ Signal 1 Name Value
[7) Video Alarm Confi Audio Loss Enable Audio Channel Config || ...
[ |audio Alarm Cona -
o Tignal 2 Audio High Threshold(dB) -1'— -
o- [ 8ignal 3 Audio High Duration(s) 114 ..
o= ] Signal 4 i h
o= [] Signal 5 Audio Low Threshold(dB) -5Dl:— -
o [ Signal 6 i =
o g signal 7 Audio Low Duration(s) 60—| -
o= ] Signal 8

Figure 3.2-7 Audio Alarm Parameters

The relationship of the alarm action switches and the corresponding
parameter are shown as in Table 3.2-1:

Table 3.2-1 The Alarm Action Switches and Alarm Parameters

Video Loss Yes/No |Yes Enable/Disable video loss alarm
Video Freeze Yes/No |No Enable/Disable video freeze alarm
Video Video Freeze Sensitivity(%) |0~100 |0 Set the sensitivity for video freeze
Alarm |video Freeze Duration(s) |0~120 |60 Set the duration for video freeze
Video Black Yes/No |No Enable/Disable video black alarm
Video Black Sensitivity(%) [0~100 |24 Set the sensitivity for video black
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Video Black Duration(s) 0~120 (60 Set the duration for video black

Enable/Disable audio loss alarm,
audio high alarm, audio low alarm

Set the threshold for audio high
alarm

Audio Loss Yes/No | Yes

Audio High Threshold(dB) 50~0 |-1

Audio |Audio High Duration(s) 0-120 |1 Set the duration for audio high
Alarm alarm

Audio Low Threshold(dB)

Set the threshold for audio low

-50~0 |-50
alarm

Audio Low Duration(s) Set the duration for audio low

0~120 |60
alarm

B Tips

* The alarm parameters whose value should be set as Yes or No are the

corresponding alarm action switches. When the alarm action switch is set
to Yes, it will process and collect the alarm information, and the other

parameters (sensitivity, duration, threshold, and limitation) are valid.

* The threshold for video alarms(Video Freeze Threshold, Video Black
Threshold): the higher percentage the threshold is, the easier the
corresponding alarm happens.

Especially, you can set audio alarm switch for each audio channel. Click
Audio Channel Config button in the value column, it will all pop up the
audio channel setting dialog box, as shown in Figure 3.2-8, each alarm is
divided into 16 channels, thus you can set Audio Loss, Audio High, or
Audio Low alarm in channel.
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Figure 3.2-8 Audio Channel Alarm Setting Dialog Box
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B Tips

* In Audio Channel Config dialog box, the audio loss alarm is set based on

audio group as a unit, the audio high alarm and the audio low alarm are set
based on audio channel as a unit. Each audio group is comprised of four
adjacent audio channels counted from No.1 channel in ascending order.
For example, the No.1~No.4 channels are belonged to No.1 Group, and so
on, there are four groups on aggregate. You need to select any one
channel belonged to the audio group, then, it will select all the four
channels of Audio Loss items automatically.

B For example: Start up the alarm detection

As shown in Figure 3.2-9, set the video loss alarm to Signall, and audio
loss alarm to the first group channels of signall.

Operation: Double click signall sub-node below Input Module node, and
click Video Alarm Config sub-node, it will display the video alarm
parameters for Signall in the property pane. Choose the Video Loss item,
as shown in Figure 3.2-9:

[ Aurora [ DEVICE | SOURCE | VIDEOWALL [ LAYOUT | | yigeo Alarm Config o
¢ [ Alarm Config i :
¢ ] Signal 1 : MName Value
E ideo Alarm Conﬁg Video Loss Enable
| Audio Alarm Config :
& [ Signal 2 Video Freeze |
Signal 3 : 5
: g s:g:; s _. Video Freeze Sensitivity(%) o
o[ Signal 5 ‘| video Freeze Duration(s) 60—
o= ] Signal & i :
& [ Signal 7 Video Black |
o [ Signal 8 i - A
o ] Signal 9 Video Black Sensitivity(%) 24'—
o [ Signal 10 i| video Black Duration(s) 60—
o= 9 Signal 11 B

Figure 3.2-9 Set Video Loss Alarm

Then, click Audio Alarm Config sub-node to display the audio alarm
parameters for Inputl in the property pane, click the value column button
for Audio Loss item, it will pop up the audio channel config dialog box, as
shown in Figure 3.2-10:
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[£] Aurora {|"DEVICE | sOURCE | VIDEO WALL | LAYOUT | Audio Atarm Config —
¢ [ Alarm Config :
¢ [ Signal 1 : : Mame Value

[ Video Alarm Confia |- i|' Audio Loss Enable Audio Channel Config || ...
[ Audio Alarm Config | i =
o= ST :| Audio High Threshold(dB) A -

[ Andio Channel Config

Audio Channel Config:

Z
o]
=
o
o]
=
(]
o
=
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o
=
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=
o
o
=
o
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=
-~

Cha Ch9 | Ch10 | Ch11 | Ch12 | Ch13 | Ch14 [Ch 15 Ch 16{[

High Enable
Low Enable
Loss Enable

I
Y M |
I
I

Figure 3.2-10 Set Audio Loss Alarm

Tick the Loss Enable item for any channel of group one(Ch1~Ch4), it will
select all the four channels automatically, and click OK button to confirm
the selection and close this dialog box. Then, select save command in file
menu to save the alarm settings to the device.

(2) Alarm Display Switch

The alarm display switch must cooperated with the alarm action switch,
that is, after the alarm action switch is enabled, if the alarm display switch
was enabled, it will display the alarm information on the display screen.

B Tips

* The prerequisite for the alarm display switch is the corresponding alarm

action switch. When the alarm action switch is enabled, the alarm display
switch is effect to the display of the alarm information if it is set as enabled,
otherwise, if the alarm action switch is disabled, the alarm display switch
will have no effect to the display of the alarm information although it is set
as enabled.

According to the different types of the alarm output devices, the alarm
display switch contains the following types:

B Alarm display switch about screen show: it is used to control whether
to display alarm information on screens.

Set it at: Layout = monitor's Element Prop pane—>Alarm table, as
shown in Figure 3.2-11:
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Alarm o~

Propertw | Value
Video Loss Display
Video Freeze Dizplay
Video Black Displaw
Audio High Enable
Audio Low Enable
Abudio Loss Display

Figure 3.2-11 Alarm Display Switch

B Tips

e The audio alarm action switch is divided into 16 selection box for each

audio channel, but the audio alarm display switch is only one for the

16-channels audio signal.

The relationship of the alarm action switch and the alarm display switch
are listed as below:

Table 3.2-2 The Alarm Display Switches and Alarm Parameters

Video Loss Video Loss Display

Video Alarm |Video Freeze |Video Freeze Display Video
Video Black Video Black Display
Audio Loss Enable

Audio Alarm  |Audio Loss Audio High Enable Audio
Audio Low Enable

B Alarm Broadcast Switch: it is used to control whether to broadcast
alarm information on speakers.

The alarm broadcast switch is set in Aurora MessageSpeech software to
decide whether to broadcast video or audio alarm information, the
prerequisite is to enable the corresponding alarm action switch.

The logic relationships among all these alarm switches and configurations
are as shown in Figure 3.2-12:
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AUROAR

Alarm Happens

Alarm Action Switch

OFF AUROAR

Alarm Speech Switch

Alarm Display Switch
MessageSpeech

Alarm RCP Switch
AUROAR-RCP

Display Alarm
Info

¥ ¥
None Speech Speech Alarm None Display
Alarm Info Info Alarm Info

Figure 3.2-12 Alarm Relationships

3.2.2 Output Format

Select the output format through the Output Format node.

Click the output format node in device tree, and it will show the drop list for
output format in property pane: 1080P50, 1080P60, 1080i50, 1080i60, as
shown in Figure 3.2-13:

Output Format -~
Name Value
Output Format 1080P30 e
1080F0
108080
1080150
1080160

Figure 3.2-13 Output Format

3.2.3 Serial Port List

Set the usage and parameters for serial port.

Double-click the Serial Port List node in device tree, and it will show the
serial ports list, including RS422, RS485-1 and RS485-2, as shown in
Figure 3.2-14.

e |jbn_'rial Port L:i.st|

[y rs422
[y rs485-1
[} rs4s5-2

Figure 3.2-14 Serial Port List
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Click the each serial port sub-node in the device tree, and the parameters
are as shown in Figure 3.2-15:

RS422 o~
Mame Value

Protocol

Data Bits g -
Stop Bits One hd
Paritw Even -
Baud Rate 33400 -
Hardware Flow Control Haone -

Figure 3.2-15 Serial Port

The parameter items and their values for serial port are as shown in Table
3.2-3:

Table 3.2-3 Parameters for Serial Port

: : Set the usage of

Protocol TSL input TSL input the interface
Data Bits 5/6/7/8 8 Set data bits
Stop Bits One/Two None Set stop bits
Parity None/Odd/Even Even Set parity

2400/4800/9600/19200/
Baud Rate 38400/57600/115200 9600 Set baud rate

* None Set
Hardware * Requestto Send None communication
Flow Control | Requestto Send X On X Off r0toCol

- X On X Off X On X Off P

BTips

* There is only one serial port for AURORA1600, and the node name is
RS422 used for TSL input.

* There are two serial ports for AURORA9600, and the node name is
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RS485-1 and RS485-2 separately, meanwhile, serial port RS485-1 is used

for TSL input, serial port RS485-2 is used for customized function.

3.2.4 System Config

Click System Config node in the device tree, it will display the system
parameters in property pane, including Device Name, IP Address,
Subnet Mask, Gateway, Language, Mute and Volume, as shown in

Figure 3.2-16:
System Config o~
lame Value

Device Hame Aurora
IF Address 192.165.1. 78
Subnet Mask 255. 255. 255.0
Gateway 192.168.1.1
Language A -
Mute ]
Volums [

Figure 3.2-16 System Config

The parameter items and their values for System Config are as shown in
Table 3.2-4:

Table 3.2-4 Parameters for System Config

Set the device name for the

Device Name |---- Aurora ..
multi-image processor

IP Address 192.168.1.70 Set the IP address for the device
Subnet Mask |---- 255.255.255.0 [Set subnet mask
Gateway 192.168.1.1 Set gateway

English/ f& {5 F|Set  the language type of
Langliage BHARERL 3% software interface
Mute Yes/No No Enable/Disable mute function
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Volume

15 0~31

Set the volume value

B Tips

The device name can be composed of any characters, and the length of

the name should not exceed 16 characters.

Restart the multi-image processor to reconnect it with the control computer
after you have modified its IP address.

3.2.5 TSL Config

Click TSL Config node in the device tree, it will display the TSL setting

parameters in property pane, including TSL Version and TSL5.0 Port, as
shown in Figure 3.2-17:

T5L Config o
Name Value
TSL Version v3. 1 hd
TSL5.0 Fert 8, 900 —

Figure 3.2-17 Other Settings

The parameter items and their values for TSL settings are as shown in
Table 3.2-5:

TSL Version

Table 3.2-5 Parameters for TSL Settings

v3.1/v4.0/v5.0 (v3.1

Set TSL version

TSL5.0 Port

0~65535 8900

Set TSL port
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3.2.6 Matrix Configuration

Click Matrix configuration button @ | in tool bar, or select Configure >

Matrix Configuration menu command, it will pop up the Matrix
configuration dialog box, as shown in Figure 3.2-18:

atriz configuration x|
-3 Input Source List OUTEUT-1 OUTFUT-2
[ sourcent
[ sourcenz
[ sourcens
[ Sourcens
[ ssurcens
[ sourcens
[ sourcent
[ sourceos
[ sourcens
[ sourcetn
[ sourcett
[ sourcer2
D soureets OUTEUT-3 OUTEUT—4
[ sources
[ sourcets
[ Sourcats . .

Figure 3.2-18 Matrix Configuration

All of the matrix output interfaces are connected to Inputl by default. Drag
a signal source node from the left source list to the matrix output interface
at the right area in this dialog box. Then, click Apply button to save the
modification.

3.3 Source Configuration

The source configuration window shows the signal sources information getting
from the connected device.

Click SOURCE tab in the top of working area, it will display the source
configuration table in working area, and the source list in system pane, as
shown in Figure 3.3-1:
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=iofx|
File Configure User Help
a

DEVICE VIDEQ WALL | LAYOUT
10 | Signal Hame | Audio Meter 1 | Audio Meter 2 | Audio Meter 3 | Audio Meter 4 [TSL3.1/4.0 Add .| TSL 5.0 Address W Type WD Text Source Left Tally Source |Right Tally Source
1 Source0l Eab 1-2 Eab 3-¢ Eab 56 Eab 78 128 o 5L TSL
2 Soures02 Eab 12 Eab 3¢ Eab 56 Eab 78 128 0 S L
3 Sourced3 Eab 12 Eab 3-¢ Eab 56 b 78 128 o 5L TS
4 Source04 Eab 1-2 Eab 3-¢ Eab 56 Eab 78 128 o 5L TSL
5 Sourcs05 Eab 12 Eab 3¢ Eab 56 Eab 78 128 0 S L
5 Source06 Eab 1-2 Eab 3-¢ Eab 56 Eab 78 128 o 5L TSL

Soures07 Eab 12 Eab 3¢ Eab 56 Eab 78 128 0 S L
s Sourceds Eab 12 Eab 3-¢ Eab 56 b 78 128 o 5L TS
9 Source08 Eab 1-2 Eab 3-¢ Eab 56 Eab 78 128 o 5L TSL
10| Sourcald Eab 12 Eab 3¢ Eab 56 Eab 78 128 0 S L
1 Sourcell Eab 12 Eab 3-¢ Eab 56 b 78 128 o 5L TS
12 | Sourcel2 Eab 1-2 Eab 3-¢ Eab 56 Eab 78 128 o 5L TSL
13 | Sourcels Eab 12 Eab 3¢ Eab 56 Eab 78 128 0 S L
14| Seurceld Eab 12 Eab 3-¢ Eab 56 b 78 128 o 5L TS
15 | Sourcels Eab 12 Eab 3¢ Eab 56 Eab 78 128 0 S L
16| Seurcets Eab 12 Eab 3-¢ Eab 56 b 78 128 o 5L TS

# Online  IP: 192.168.1.70

Figure 3.3-1 Source Configuration Window

As shown in Figure 3.3-1, each input signal has these properties: ID, Signal
Name, Audio Meter 1, Audio Meter 2, Audio Meter 3, Audio Meter 4,
TSL3.1/4.0 Address, TSL5.0 Address, UMD Type, UMD Text Source, Left
Tally Source, and Right Tally Source.

Click the Audio Meter* cell to show the drop down list, each audio meter
contains 8 groups of audio channels, each group contains two channels. For
example: Emb1-2 contains the first and the second channel audio information,
and so on.

B Source Configuration

The source items that could be configured are listed in this table, as
shown in Figure 3.3-2:

DEVICE VIDEO FALL | LatOUT |

I0 | Sigual Neme | Audio Meter 1 | Audis Meter 2 | Audio Meter 3 | Audio Meter 4 |TSL3.1/4.0 Add .| TSL 5.0 Address W Type UMD Text Source Left Tally Source |Right Tally Scurce
1 Source0l b 12 Eab 34 b 56 Eab 72 128 0 Sta S— TSL TSL

2 Sourc02 b 12 Eab 34 b 56 Eab 72 128 o Static — TS TSL

3 Sourc03 b 12 Eab 34 b 56 Eab 78 128 o Static sourcald TS 5L

4 Source04 b 12 Eab 34 b 56 Eab 78 128 o Static S—— TS 5L

5 Sourcel5 Emb 1-2 Emb 34 Emb 56 Emb 7-8 128 o Static our ce0S TSL TSL

Figure 3.3-2 Source Configuration Table

The ID number of the source interface, it is not
ID editable and allocated by the system, the value is|1
"interface number”.

Signal The name of the signal source, it is “interface

Name type"+ "ID number" and editable. Signall

Set the audio channels for this audio meter, you
can select among these items: Emb 1-2
Emb 1-2, Emb 3-4, Emb 5-6, Emb 7-8, Emb 9-10,

Audio
Meterl
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Emb 11-12, Emb 13-14, Emb 15-16

Audio

Meter 2 The same as above Emb 1-2
Audio The same as above Emb 1-2
Meter 3

Audio The same as above Emb 1-2
Meter 4

TSL

3.1/4.0 Set the address ID for this TSL 3.1/4.0 protocol TSL: 128
Address

TSL 5.0 Set the address ID for this TSL 5.0 protocol TSL: 10
Address

Set the type for UMD source as static or dynamic.
UMD Tvpe If it is static, the UMD content will be the value set Static

yp in UMD text; If it is dynamic, the UMD content will

be the value received from the TSL protocol
UMD Text| set the static UMD text CCTV6
Source
Left Tally|Set the interface number through which will
Source receive the left TALLY source e
Right Tally|Set the interface number through which will GPI1 or TSL

Source receive the right TALLY source
B Tips

* The TSL Version selection is set in Source>TSL Config>TSL Version

item.

B Rename the signal source

Click the name cell to modify the name of the signal source, and the
source name in Device configuration will be changed synchronously.
For example: modify Signall to be "Source 1", as shown in Figure

3.3-3:
0 Signal Name Audio Meter 1 Audio Meter 2 Audio Meter 3 Audio Meter 4 | TSL 3.1/4.0 Addr...
1 I Source I] Emb 1-2 Emb 3-4 Emb 5-6 Emb 7-8 128
2 Signal 2 Emb 1-2 Emb 3-4 Emb 5-6 Emb 7-8 128
3 Signal 3 Emb 1-2 Emb 3-4 Emb 5-6 Emb 7-8 128

Figure 3.3-3 Rename the Signal Source
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B Tips

* In the Source configuration table, all the cells except ID item support the

shortcut operation of Copy(Ctrl+C) and Paste(Ctrl+V) which are convenient

for source items edit.

3.3.1 Set Audio Source

Set the audio source for an audio meter, each audio source is a group of
audio channels which contains the information of two audio channels.

B Set audio source

Click each audio meter cell to choose an audio channel group from the
audio channel drop down list. For example: click the Audio Meterl cell in
Signall information line, and select Emb 1-2 as its value, as shown in
Figure 3.3-4:

DEVICE | SOURCE [ VIDEO WALL | LA¥QUT

ID | Signal Neme | Audio Meter I | Audio Meter 2 | Audio Meter 3 | Audio Meter 4 |TSL 3.1/4.0 Add TSL 5.0 Address D Type TMD Text Sewrce Left Tally Source |Right Tally Source|

1 Source0l Enb 1-2 Emb 34 Eub 56 Enb 78 123 0 Static source0l 8L 8L

Seurce02 Emb 1-2 Emb 3-4 Enb 56 Enb 78 128 0 Static source02 8L 8L

2
3 Source03 [hudio Neter Zl. source03 TSL TSL

4 SourceDd Eob 1-2 Enb 5~ Enb 58 Enb 8 i o sourceds TsL TsL

Sourceds Emb 9-10 ‘ Emb 11-12 | Emb 13-14 ‘ Emb 15-16 . sourcels L st

3 Seurce0f i source06 5L 5L

SourcedT L sourcs0T 5L 5L

8 Source08 L sourcs08 5L 5L

7 Sourcens # Double=click the complete selection . sourca0s TsL sL

Figure 3.3-4 Set Audio Channels for an Audio Meter

B Tips

* Each audio meter in Audio Meter1l~ Audio Meter4 contains a group of

audio information which has two audio channels, and the Audio Meterl~
Audio Meter4 matches the audio meter on monitor window displayed on

video wall from left to right in sequence.

3.3.2 Set UMD
Set the UMD source through UMD Type and UMD Text cell, it could be

static word or dynamic content from TSL protocol.

B Set UMD Source
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Set the source for UMD content according to the UMD type as static
or dynamic.

O Static UMD: Set the UMD Type as Static, and input word in UMD
Text cell. For example: set Static as UMD Type, and input CCTV9
in UMD Text cell, as shown in Figure 3.3-5:

O Dynamic UMD: Set the UMD Type as Dynamic, and input the
address ID in TSL 3.1/4.0 Address or TSL 5.0 Address cell which
will receive the UMD information from TSL protocol. For example:
set Dynamic as UMD Type and input 1 in TSL 5.0 Address cell, as
shown in Figure 3.3-6:

DEVICE | SOURCE | VIDEO WALL | LAVOUT |

10

Signal Name Audio Meter 1 Audio Meter 2 Audio Meter 3 Aundio Meter 4 (TSL 3.1/4.0 A TSL 5.0 Address UMD Type UMD Text Seurce Left Tally So

1

Sourcell Emb 1-2 Emb 34 Emb 5-6 Emb 7-8 128 1] Static CCTVS TSL

2

Sourcel2 Emb 1-2 Emb 34 Enb 56 Emb 78 128 1 Dynsmic |  sourcel 02 TSL

3

Source03 Emb 1-2 Emb 34 Emb 56 Emb 78 128 i} Statie |  source( 03 TSL

Figure 3.3-5 Static Source for UMD

[‘bEvice | sourcE | viDEo waLL | Lavour |

I Signal Name Audie Meter 1 Audio Meter 2 Audio Meter 3 Audio Meter 4 |TSL 3.1/4.0 A .| TSL 5.0 Address D Type D Text Source Left Tally So...
1 Sourcell Emb 1-2 Emb 34 Emb 56 Emb 7-8 128 0 Static CCTVe TSL
2 Sourcel2 Emb 1-2 Emb 3-4 Emb 5-6 Emb 7-B 128 1 Dymamic sourcel2 TSL
3 Sourcel3 Emb 1-2 Emb 34 Emb 56 Emb 78 128 0 Static sourcel3 TSL

Figure 3.3-6 Dynamic Source for UMD

The range for TSL port is 0~65535.

3.3.3 Set TALLY Source

Set the tally source in Left Tally Source and Right Tally Source cell, it could
be from GPI port and TSL port.

B Set Tally Source

Set the source for left tally and right tally. Tally source could be
GPI(0~144), or TSL(0~65534).

For example: Double click the Left Tally Source cell in Signall source
information line, it will pop up the GPIO/TSL list, select the source
type as GPI or TSL, and select its address ID, as shown in Figure
3.3-7:
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[‘DEvIcE | 'source | vieo AL | Lavour |
10| Sigual Name | hudio Meter 1 | udio Meter 2 | Audio Meter 3 | Audis Meter 4 |TSL 3.1/4.0 A .| TSL 5.0 Address| UMD Type MD Text Sowrce  |Left Tally So...
1 Sourcell Eab 1-2 Eab 34 Eub 56 Eab 78 128 0 Statie soures0l 5L
2 Soureel2 Emb 1-2 Emb 3-4 Emb 56 Emb 7-B 128 0 Statie soures02 TSL
2| s | whiz [ e x}
4 Sourceld Eab 1-2 Eab 34 ®F O 5L L
5 Soureels Emb 1-2 Emb 3-4
P10 P11 o1z loP13 P14 w15 3G lep17
6 Sourcelf Enb 1-2 Eab 34
GPI8 GPIS GPT10 GPT11 GPT12 GPI13 GPT14 IGPT15
Sourcel? Eab 1-2 Eab 34
] Sourceld Enb 1-2 Fmb 34
g Sourceld Enb 172 Emb 34 * Doubleclick the complete selection
10 Sourecelld Emb 1-2 Emb 3-4 Enb 56 | Fmb ‘ 12 | 0 ‘ tatie |  source 10 TSL

Figure 3.3-7 Set Tally Source

Click OK to save the choice.
Then, click Save button in tool bar to save the modification.

3.4 Video Wall Configuration

You can define various video walls according to the arrangement, and each
arrangement can be set multiple layouts.

3.4.1 Create a Video Wall

Create a video wall at first.

Operations: Click Video Wall tab VIDEOWALL | to switch to monitor

configuration window. Click New button in tool bar, or select File> New
menu command, it will pop up the New Wall dialog box, as shown in
Figure 3.4-1:

x

Enter the name of Tall: [WALLOL

Figure 3.4-1 New Wall Dialog Box

B Video Wall Name
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Input a name for the monitor in Enter the name of Wall field. The name
can be composed of any characters, and the length should not exceed 16
characters. Click Create button to add a new video wall to the video wall
list.

For example: input WallO1 as the name, then click Create button at the
bottom of the dialog box, it will add WallO1 to the video wall list above, as
shown in Figure 3.4-2:

FECTE x)
[ hac

Enter the name of Fall:

Figure 3.4-2 Video Wall List

B Video Wall Properties

The video wall properties are listed in its property pane, as shown in
Figure 3.4-3:

Wall Properties ~

Property Value

Hame WALIO1

Horizontal Screen WNumber |2

Vertical Screen Number 2
Horizontal Gap ]
Vertical Gap 0

Audio Output Card

Figure 3.4-3 Property Pane for a Video Wall

Name -- -- Set the name of the video wall.
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Horizontal Set the screen number in horizontal

Screen 0~36 2 direction in a video wall. Each screen is a

Number display unit.

Vertical Set the screen number in vertical direction

Screen 0~36 2 in a video wall. Each screen is a display

Number unit.

Horizontal Set the gap size at the horizontal direction
0~100 0 L

Gap between screens, the unit is pixel.

Vertical 0~100 0 Set the gap size at the vertical direction

Gap between screens, the unit is pixel.

Audio

Output i\llqone/Outpu None Set the position of Audio output card

Card

B Tips

* The audio output card function is only supported in AURORA9600 9U

multi-image processor. One of the output channels will be occupied as the
audio output card function, then there will be only 15 channels left for video

output.

For example: as shown in Figure 3.4-4, the screens in horizontal direction
and vertical direction are both two, the red arrow indicates the gap in
horizontal direction, that is called horizontal gap; the green arrow indicated
the gap in vertical direction, that is called vertical gap, the unit is pixel.

Horizontal Gap

Vertical
Gap 7

Figure 3.4-4 Gap lllustration for a Video Wall

The available output interfaces and common video walls are listed in the
system pane of video wall configuration.

B Output: Appoint an output interface for each screen in the video wall.
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O Output interface status: click the Outputs tab, and double click
the "Output*" root node, it will show the output interface list, as
shown in Figure 3.4-5. Connect an output interface with a screen.

Ij Output
|j| Output 1-1
D Output 1-2
|j| Output 1-3
D Output 1—4

Figure 3.4-5 Outputs for a Video Wall

BTips

* Each output card is composed of four output channels, supports up to 16

video monitors, refer to “3.5.3.1 Monitor” for the details about how to set

parameters for video monitor element.

O Build the connection between the screen of a video wall and
an output interface: Each output interface can only be assigned
to one screen of a video wall. Click the output interface from the
outputs list, and then press the mouse button down and drag it to
the target screen, thus to realize the connection.

For example: allocate output interface

As shown in Figure 3.4-7, assign Outputl-1 to the top left screen in
the video wall. Drag the selected output interface to the screen, there
will be a "1-1" icon on the screen, and the assignments to other
screens are the same.
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Figure 3.4-6 Assign Outputs for a Screen

O Delete the connection between the screen of a video wall and
an output interface: click the close buttonll at the top right of
the screen to delete the connection between the screen of a video
wall and its output interface.

For example: Create a 2*2 video wall, and allocate to the output interface
1 to 4 separately, as shown in Figure 3.4-7:

B Aurora Bulti-image System Editor (ol x|

File Configws Ussz Halp
O & m [ S5 2 cinin

= Output DEVICE | SOURCE | VIDED RALL | LAXOUT Fall Properties ~
Output 1-1 ./

Output 1-2 Praoper .
Output 1-3 ./ wall
Output 1-4 ./

[l

Horizontal Screen Number |2
Verticsl Sereen Number |2
Horizontal Gap

Vertical Gap

Audio Output Card

Fallol
# OnLine IP: 192.168.1.70 ||| OO

Figure 3.4-7 Create a Video Wall
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B Tips

The screen number added in horizontal direction or vertical direction of the

video wall can't exceed 36 separately, each screen is a display unit

physically.

* The screens of a video wall are divided by white lines, and the name of a

video wall is the tab title at the left bottom area of the working area.

3.4.2 Save a Video Wall

Save a video wall to synchronize its information to the current connected
multi-image processor.

B Save

Operation: Click OK button at the Create a Video Wall dialog box, it will
pop up the save successfully prompt, as shown in Figure 3.4-8:

Tio x|

T m
| Save successfullw

0K

Figure 3.4-8 Prompt for Saving a Video Wall

Click OK button to close this prompt, and confirm the saving operation.

If you have modified the properties of a video wall, such as screen number,
click the save button [®]| in tool bar, or select File->Save menu command
to save the changes, if save successfully, the prompt is as shown in

Figure 3.4-8.
x
? Changze the Video wall, %11l delete all templates, sure to delete?

Yes Ha

Figure 3.4-9 Prompt When Changing the Video Wall Properties

If you have modify the properties of the video wall, the layouts you have
made for the original video wall is no longer fit for the new one, click Yes to
confirm the save and it will delete all layouts; click No to cancel the save
operation.
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3.4.3 Open a Video Wall

Open an existed video wall from the video wall list, and it will be displayed
at the working area.

Operation: Click Open button, or select File>Open menu command to
open an existed video wall from the video wall list, it will pop up the dialog
box, as shown in Figure 3.4-10:

i

e [ Type [ Model Count State

Wallol 2X2 [} Opened

Figure 3.4-10 Open a Video Wall Dialog Box

The video wall list at the top area of this dialog box, including these items:
Name, ID, Type, Model Count and State.

B Video Wall Preview

Click a video wall in the video wall list, the preview of the selected video
wall will be display at the bottom area of the dialog box, as shown in
Figure 3.4-11. Each output interface assigned to the screen of the video
wall displays at the top left corner of the screen in the preview. Then, click
Open button in this dialog box, it will be opened in the working area.

Click Close button in this dialog box, it will close the current selected
video wall. Click Delete button to delete the video wall in the video wall list,
and click Quit button to close this dialog box.
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Preview:

Figure 3.4-11 Open a Video Wall Dialog Box

The name of the opened video wall in the working area will be displayed
as its tab name at the bottom of the working area.

3.4.4 Other Operation for a Video Wall

1. Close a Video Wall
It is used to close the current editable video wall in working area.

Operation: Click Close button| gg |, or select File>Close menu command
to close the current video wall without any prompt.

2. Delete a Video Wall
It is used to delete the current editable video wall in working area

Operation: Click Delete button L%/, or select File->Delete menu

command to close the current video wall, and it will pop up a prompt for
confirm the deletion, as shown in Figure 3.4-12. Click OK to delete the

video wall, or click No to cancel the deletion.
confirn X

? Confirm to delete the Video Wall?

0K Cancel

Figure 3.4-12 Prompt for Delete a Video Wall

3. Screen Label

The Screen Label is used to prompt the physical position of the screen for
the user when installing the screens. The label will show in the center of a

screen as the format of "1-1".

82



nsee Functionalities and Operations

Operation:

B Open Screen Label: the label of a screen is closed by default, click the
Open Screen Label button , it will show all the labels, and the

button is pressed down to be in blue .

B Close Screen Label: after open the screen label, click the Close
Screen Label button , it will hide all the labels, and the button is

pressed down to be in gray [ |.

3.5 Model Configuration

It will introduce the following subjects for Model Configuration:
B Model Configuration
H Tool Bar
B Elements Properties
B Elements Layouts

The details are as below.

3.5.1 Model Configuration

It will introduce the creation, open, deletion and other operations for model
configuration.

3.5.1.1 Create a Model

Create a model before your do the layout operation, and it is easy to use
this software to customize and realize the desired layout as need.

Operation: click Layout tab in the working area to switch to the model
configuration window, as shown in Figure 3.5-1, the system pane and the
property pane are also changed, the system pane contains Signal List
and Templates, and the property pane contains Elements Properties
and Model Properties.
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D Source(2 | :
[ sourcens
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D Sourcel’
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1270 , __
# Online IP: 192 168.1.70
Figure 3.5-1 Layout Configuration Window

=
al

Click New button to pop up the New Model dialog box, as shown in
Figure 3.5-2:

x

Video Wall:

[ mallon

Enter the name of Layout: |LayoutOl
o]

Figure 3.5-2 Create a New Model Dialog Box

| Create

You can create multiple layouts for a video wall. Input the model name in
the Enter the name of layout field, for example, input Layout01 as the
new model name, then click Create button to add a new layout to the
video wall, and click OK button to save the creation, and it pop up a
prompt for the save, as shown in Figure 3.5-3:
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Tir x|

.-"fr
I\D Create Lavout sucecessfullw.

0K

Figure 3.5-3 Prompt for Save Successful

BAurora Bulti-image Systea Editor =10l
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# online TP 192.168.1.70
Figure 3.5-4 The New Model

As shown in Figure 3.5-4, open the new model, and its name is
shown as the title of the model tab at the bottom of the working area,
the format of the tab is "video wall name" +"-"+"model name".

3.5.1.2 Open a Model

You can open, delete and close a model in the Open Model dialog box.

Operation: Click Open button| g | to pop up the Open Model dialog box,

as shown in Figure 3.5-5, click the expand icon< in the front of the video
wall name to expand all of the models.
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[ oper |[ctame ] [petose ] [ |

Figure 3.5-5 Open a New Model Dialog Box

The video walls and their corresponding models are listed in the top area
of the dialog box, including the following items:

It shows the name of the video wall

Name and the model.

It shows the number of the

Window Count | 0~36 sub-windows in the model.

It shows whether the model is opened

State Opened/Unopened |. .
in working area or not.

It shows whether the model is used by

Current Model |Yes/No o
its video wall currently.

The preview of the current selected model displays at the bottom area of
the dialog box

Click Open button, or double click the model information line, the selected
model will be displayed in the working area, the name is shown as the title
of its tab at the bottom of working area, and the background of the tab is
highlighted, as shown in Figure 3.5-6:
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Figure 3.5-6 Open a Model

Click Close button to close the opened model in working area,; click
Delete button to the delete the selected model in the model list above;
click Quit button to close this dialog box.

B Show Output Information

In the layout editing area, press Show Output Information| T | button in

the tool bar to be selected status

T

, it will highlight the output interface

information and the brim of the display screens, as shown in Figure 3.5-7,
and the other elements windows will be masked, thus you can perceive

the brim of the screens, and arrange the position of the elements windows
more legibly and equitably.

Then, click Show Output Information| T

display of the output Information, and the elements windows will be
displayed as normal, as shown in Figure 3.5-6.
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[‘pEvice | source | vIDEO WALL | LavOUT |

NEDEEEIEREER

Figure 3.5-7 Show Output Information

3.5.1.3 Save a Model

B Save current model

The name of the current opened models are displayed as tabs at the
bottom of the working area, and there will a star icon* after the name of
which model has not been saved after modified, as shown in Figure 3.5-8,
click Save button in the tool bar to save the modification, and the star icon
will be disappeared.

| #¥all0lLayoutdl | Fallol-Layout0? |

Figure 3.5-8 Tab Name for Models

There will be a save prompt, as shown in Figure 3.5-9. Click Close button
to confirm the completion.

Tir x|

\.\\-!_j Save Successfullw

0K

Figure 3.5-9 Save Prompt

B Save All

Click Save All button at the tool bar, it will save all the changes to the
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models opened currently in the working area, this operation will do a quick
save operation to the opened models.

Click Open button to display the Open Model dialog box, it will show the
model list, as shown in Figure 3.5-10:

Eopen Hodel x|
Yeme | Findos Count | State | Current Wodel

9 [ClWallol

ey |6 Tl la

[ Layouto2 6 Opened Vo

[ Layouto3 4 Opened Vo

[ ctome |[ petere || e |

Figure 3.5-10 The Model List in Open Dialog Box

3.5.1.4 Model Properties

You can check or modify the properties of a model in its Model Properties
pane.

The property pane at the right area of the software interface contains two
tabs: Elements Prop and Model Prop, click the tab to display the
corresponding property pane.

Operation: click Layout tab to display the model properties, as shown in
Figure 3.5-11:
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Model

|/E1E|]1Ent Frop |/H|:|de1 Frop |
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Value

Lavout Name

Layoutll
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=]

Horizontal Splitter

[ ]

Vertical Splitter

2

Output Audio Type

Digital Audio -

bnalog Audia

Figure 3.5-11 The Model Properties Tab

The model properties contain the following items:

Layout Name - -- Set the name of the model.

Transparency 0~100 75 Set the transparency of the overlap
area among element windows.

Horizontal Splitter [1~4 1 el th? spl_ltters nt_megr for a
screen in horizontal direction.

Vertical Splitter 1-4 1 Set the splitters number for a
screen in vertical direction.

. - : Digital - .
Output Audio Type |Digital Audio Audio Set the digital audio type.
Analog Audio None -- Set the digital audio channel.

For example:

Set both the Horizontal Splitter and the Vertical Splitter

to be two, the screen in a video wall is as shown in Figure 3.5-12, each
screen is divided by the splitter into 2*2 cells.
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Wallol-Layout0l

Figure 3.5-12 The Splitters-4*2

B Tips

* The splitter assists in editing element windows such as move, align, adjust

windows and so on.

3.5.1.5 Other Operations to Model

1. Close a Model

Use the close command to close the current active model in working area.
Operation: if the current active model in working area has been modified

and saved, then click the Close button | gg | in tool bar, the model will be

closed and no prompt.

Otherwise, if the current active model in working area has been modified
and not jet saved, then click the Close button, there will a prompt, as
shown in Figure 3.5-13:

x

? WallOi-Layoutll
had been modified, Sawve changes?

Tes i) Cancel

Figure 3.5-13 Prompt for Model Save

Click Yes to confirm the save, and close the model.
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2. Delete a Model

Use the delete command to delete the current active model in working
area.

Operation: click Delete button| L% | in tool bar to delete the current active

model in working area, it will pop up the prompt as shown in Figure 3.5-14,
click OK to confirm the deletion, and the model will be deleted.

x

?

H Confirm to delete layout?

0K Cancel

Figure 3.5-14 Prompt for Model Delete

3. Display Current Layout to Device

Use this command to set the current layout in working area to be
displayed synchronously to the display device.

Operation: click Display Current Layout button [33/| in tool bar to make
the current layout in working area to be displayed synchronously to the
display device.

Besides, click Switch button in Model Edit dialog box by selecting Layout
Editor command, it will also make the current layout in working area to be
displayed synchronously to the display device, the details are as below.

4. Layout Editor

Use this command to sort, switch, open the selected model in a video wall
and so on. Click Layout Sorting&Switching button | 25/ in tool bar, or

select Configure—>Layout Editor command in menu bar, it will pop up the
layout editor window, as shown in Figure 3.5-15:
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Figure 3.5-15 Layout Edit Window

Choose a video wall from the drop down list of Video Wall, it will show all
models of this video wall in the Model List area, and each model shows
the following items in the table below:

Name It shows the ID number of the model.
\(/:V(;rlli(taw 0~36 It shows the number of the sub-windows in the model.
Current It shows whether the model is used by its video wall

Model Ve currently.

B Model Sequence

Click to select a model information line in Model List, it will show its layout
preview at the right area of this dialog box, now, click Move UP, Move
Down, Move Top or Move Bottom button to rearrange the sequence of
this model in the model list, then click Save or Switch button to confirm
the rearrangement, and the sequence of model in the TV wall list is
corresponding to the button in Aurora RCP device.

B Tips

e Particularly, for AURORA1600 1U, the model sequence is corresponding to

the model selection button of Aurora RCP device in sequence, for example,

KEY1 is corresponding to the first model in the model list, and so on.

* For AURORA9600 9U, there is no corresponding RCP device, the model
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sequence of AURORA9600 9U has no practical meaning.

For example: set the corresponding relationship between AURORA1600
1U and AURORA-RCP. The original sequence for LayoutO1 is KEY1 in
Aurora RCP, then please modify KEY1 to Layout02.

Operation: Click the Model Editor button | 23/ in tool bar, it will pop up
the model editor dialog box, as shown in Figure 3.5-16. Select WallO1,
and choose Layout02 in model list, click Move Up button to resort it to the
top of the model list.

Video Wall: [Fallor n

Name Tindow Count Current Model
Layout02 Wa
Layoutll ] Tes
Layoutl3 4 la

X

| Move Up || Move Down |

| Move Top || Move Bottom |

-
Figure 3.5-16 Move the Sequence of Layout02 in Layout Editor

Layout02 is moved to the first line in the model list of WallO1 video wall,
click the OK button or Apply button to confirm the modification, and you
can see the sequence of the model has been changed. Then, if you press
KEY1 in Aurora RCP, it will switch to the Layout02 layout.

B Switch

Click the Switch button to change the selected model as the output layout
for the selected video wall, that is the same as selecting Display Current
Layout command.

Operation: select a model line, and click the Switch button in the dialog
box, the selected model will be output as the output layout for the selected
video wall.

5. Resource Connection

You should connect a signal resource for the selected monitor window
element. Click the Signal List in system pane of the Model configuration
window, and double click the input model node to expand its signal source
sub-nodes. Select a signal source sub-node, and drag the sub-node to a
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desired monitor window in working area, release the mouse button to
complete the connection.

If you need to reconnect a new signal source to the target monitor window,
then select a new signal source sun-node, and drag it to the target monitor
window to replace the old one.

For example: select SourceO1 sub-node, press the left mouse button
down, and drag it onto the Monitor(1) window, you can see the Source
information in Monitor(1) is changed to Source01, as shown in Figure
3.5-17:

Signal List | Templates | |(oevice [ "source | viveo waLL [ ravour

s saueeitis: D=0
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Sl:-u.rce':IE
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' acation : [42,0,3 - [100z, 0,8

e . Sourcell

D Sourceld N
D Sourcela :
D Sourceld 5
D Sourced7 ame |, itor ame : (4)Meni ter
DSnurce':IS : 0. 8 + [100z

|j| Source(d
ﬁ Sourcell

Figure 3.5-17 Connect a Signal Source for a Monitor Window

6. Layout Arrangement

Each output interface is connected with a video screen, keeping one to
one relationship. The solid line labeled a rectangle area in the model is
corresponding to a physical display screen device.

According to the amount of the output interfaces, AURORA1600 supports
up to 4 pieces of screen arrays, and AURORA9600 supports up to 36
pieces of screen arrays(4X9). Currently, AURORA control software
supports the above two types of multi-image processor, The arrangement
of each type of multi-image processor supports the reasonable
arrangement types within the maximum screen amounts, recommended
adjacent layout pattern.

For example: using an AURORA9600 multi-image processor, and 16
pieces of screens, recommended to be arranged as 4X4 arrangement, as
shown in Figure 3.5-18:
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Figure 3.5-18 Screen Array

Each output interface is connected with a video screen, keeping the one to
one relationship. The arrangement of each type of multi-image processor
recommends to use adjacent layout pattern, in order to arrange wires
simply and economically.

For example: using an AURORA9600 multi-image processor with four
output interfaces. For each output card connecting a display screen,
supports to use the following arrangements, as shown in Figure 3.5-19,
Figure 3.5-20, Figure 3.5-21:

ik -2

1-3 1-4

Figure 3.5-19 Screen Array-Arrangementl

/5 % /o 1-4

Figure 3.5-20 Screen Array-Arrangement2
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X

1-2

Figure 3.5-21 Screen Array-Arrangement3

As usual, the combination of monitor window, clock window and date
window could be distributed arbitrarily on the screen connected with an
output interface. According to the position of the monitor window, if the
monitor window occupies on two screens or more than two screens, it is
called as crossing layout.

Here, each output card supports up to 16 monitor windows with none
screen crossing characteristic. When the monitor window has crossed
screens, the partial area of the monitor on each screen connected with
one output interface is counted as one monitor window nominally.

B Tips

e Each output card (each group of interface on an output card) supports up

to 16 monitor windows without screen crossing.

MONITOR MONITOR

1-3 1-4 2-3 2-4

..................................................................................

Figure 3.5-22 Screen Array

For example: as shown in Figure 3.5-22, MONITOR1 occupies four
partial screens connected with No.1 output interface, No.2 output interface,
No.3 output interface, No.4 output interface of No.1 Output card, that is
counted as four windows. MONITOR2 occupies also four partial screens
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connected with No.1 output interface, No.4 output interface of No.1 Output
card, and No.1 output interface, No.3 output interface of No.2 Output card,
thus, up to six windows for No.1 output interface, two windows for No.2
output interface.

In this way, there could only be 10 none crossing windows left on the
screen array(1-1, 1-2, 1-3, 1-4) of No.1 Output card, the calculation
formula is 16-4-2=10, besides, there could only be 14 none crossing
windows left on the screen array(2-1, 2-2, 2-3, 2-4) of No.2 Output card,
the calculation formula is 16-2=14.

B Specially, please avoid using the crossing layout for analog clock
element. Take the following illustration as an example to this point. For
example: as shown in Figure 3.5-23, the analog clock is arranged
between the two screens connected with the first and the second
output interface, please do not use this kind of arrangement for the
analog clock window.

=3

L

1-3 1-4

Figure 3.5-23 Screen Array-Analog Clock

3.5.1.6 Templates

For simplify and facilitate the process of model configuration, we provide
some templates in the Templates pane, including default templates and
customized templates, separately listed.

Click the Templates tab at the left pane of the model configuration window,
and it lists the templates pane, as shown in Figure 3.5-24:
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Signal List Templates

Defaul ts e

Custom s

Figure 3.5-24 Templates

The pane is divided into the upper part and the lower part, corresponding
to the defaults and the customized separately. The defaults templates are
defined by the system, unmodified or deleted, and the customized
templates could be defined, modified and deleted by the customers.

1. Create a Template

After creating a new layout, click Add Template button, it will prompt
the Input dialog box, as shown in Figure 3.5-25, input the new name for
the template, click OK button to confirm the creation, you will see the new
template added into the Custom list.

Input |

- Input Wame For Template :

] 4 Cancel

Figure 3.5-25 Dialog Box for Adding a New Template

2. Apply Template to Current Layout

Select a template in the Templates pane, and click Apply Template to
Current Layout button, it will pop up a prompt, as shown in Figure
3.5-26, click Yes button to confirm the application, you will see the
template applied to the current layout.
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Confirm

IE' bre wou sure to apply the template to current layout?

Figure 3.5-26 Prompt for Apply a Template

3. Delete Template

Select a customized template in the Templates pane, and click Delete
buttonBe), it will pop up a prompt, as shown in Figure 3.5-27, click Yes
button to confirm the deletion, you will see the template deleted from the

Templates pane.
Confirm

IE‘ Are wou sure to delete the template?

YTes la

Figure 3.5-27 Dialog Box for Deleting a Customized Template

3.5.2 Tool Bar

1. Tool Sort

Aurora provides various tools for Layout configuration, and the tools are
used for drawing and editing for the layout, as shown in Figure 3.5-28 and

Figure 3.5-29, the tools are showed as shortcut buttons, click the button
to active the corresponding command.

D|&[mE = 0] [B[2]&] o]~ @& (e [-[a[=]e] [T
Figure 3.5-28 Common Tool Bar for Model Configuration

KD O B E| X = T 82

Figure 3.5-29 Edit Tool Bar for Model Configuration

There will be a tip besides the tool button when moving the mouse cursor
on the button, as shown in Figure 3.5-30:

&

Select Tool

Figure 3.5-30 Tip on Tool Button
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The tool bar is divided to common tool bar and edit tool bar according to
the position, as shown in Figure 3.5-28:

B Common Tool Bar: as shown in Figure 3.5-28, the tool bar labeled in
red rectangle is the common tool bar, it provides the common used
command for model configuration, such as Open, Close, Copy and so
on, it is at the below of the menu bar by default.

B Edit Tool Bar: as shown in Figure 3.5-28, the tool bar labeled in green
rectangle is the edit tool bar, it provides the editable used command for
model configuration, such as drawing and layout, as shown in Figure
3.5-31, this tool bar is at the top edge of the working area by default.

A D@ B8 & xm=m T||=a s

Drawing Tools

Figure 3.5-31 Edit Tool Bar

Thereinto, the layout tools provide align commands for multiple
element windows in working area, such as align left, align right, align
top and so on, and the split and expand command are fit for single
element window. The drawing tools provide for drawing various
elements, such as monitor, digital clock and so on.

BTips

Particularly, the shape of the mouse cursor will change to the
corresponding icon when you click an element tool button in order to

remind you what kind of element you are drawing.

Select another element tool button (monitor, analog clock, digital clock and

digital date) or click Select button | k |, or press ESC key to cancel the

selection for the current element tool button.

2. Tool Button Status
There are following statuses for the tool button:

B Unavailable: the tool button is in grey that is the button can't be used,
and the condition is not satisfied. For example: if the model is vacant,

the Copy Size button is grey 1, for there is no element window to be
copied, so this button is unavailable.

B Available but not selected: if the button is in black and the background
of the tool button is in white, that is the button is available but not
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selected. For example: if you have add a monitor element window, the
Copy Size button is turn black , how it can be used.

B Available but selected: f the button is in black and the background of
the tool button is in blue, that is the button is available and in use
currently. For example: if you have add a monitor element window,
and click the Copy Size button, the button is turn black and in blue

background , thus you can copy the selected window to another
element window. Click the button again to cancel the selection.

BTips

* if any one of the element tool buttons (monitor, analog clock, digital clock

and digital date) is selected, press the ESC key will cancel the selection for

the button, the mouse cursor will be back to on Select tool| k |, and the

selection for the element window in working area will be canceled, too.

* Click the blank area in working area using magic wand, it will add a monitor

window large enough in customized aspect ratio to full fill the blank area.

* Referto "2.3.1.4 Model Configuration Window" for the details about the

shortcut tool buttons in tool bar.

3.5.3 Elements Properties

To complete the layout for a video wall as model configuration, you should
add various element windows on the screens.

B Element Type

Use the drawing tool to add rectangle window in working area, each kind
of drawing tool adds different type of element. Aurora provides the
following element type as shown in Table 3.5-1:

Table 3.5-1 The Element Type
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Hame |:1 :'H-:-ni tor
I on o [
| Monitor I
(5] Digital Date
Ea Digital Clock
(] Analog Clock 9 3
5 4
7 5 5

B Element Properties
The Properties are different for various elements.

Select an element in working area, its properties will be displayed in the
Property Pane. For example, select an analog clock, its properties are as
shown in Figure 3.5-32:

{‘DEVICE | source | VIDEQ WAL | LavouT | | Element Prop | Model Prop |
Koes B X=T B |ose o
'

Property | Value

Starting [—Coordinate |2, 963

Starting T—Coordinate |[408

dth 675

Offzet(hour) 0

__________

Figure 3.5-32 Model Properties

The property parameters are listed in Properties pane, click the control
button -—/— to expand or collapse the list.

The properties are as below:
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3.5.3.1 Monitor

1. Properties

There are multiple tables for a monitor in its property pane: Appearance,
View, Alarm, Border, Audio and UMD/TALLY, the details are as below:

B  Appearance

The appearance properties contain the position parameters, the size
parameters for a monitor element, as shown in Figure 3.5-33. The
appearance is changing with the changes of the appearance properties.

Appearance s
Property | Value
Monitor Name IH-:-ni tor
Azpect Ratia 16:9 -
Source Aspect Ratio Reserved -

Starting I Coordinate 42

Starting YCoordinate 0

Width 373

Height 240

IMD Display Mode Outside Monitor b

Figure 3.5-33 Appearance Properties

H View

The view properties express the display information for a monitor display,
as shown in Figure 3.5-34:

View ~

Property | Value

Main Tindow L]

Video Format Enabled ]

Format Detective Hone b
Marker Enabled D
TC Enahled L]

Figure 3.5-34 View Properties
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B Alarm

The alarm properties express the settings whether to enable the alarm
information, as shown in Figure 3.5-35:

Alarm o~

Property | Value

Video Loss Displaw

Video Freeze Display

Video Elack Display

Audio High Enahble

oo o |

Audic Low Enahle

Audio Loss Displaw D

Figure 3.5-35 Alarm Properties

B Border

The border properties are used to set the border properties for the monitor
display, as shown in Figure 3.5-36:

Border o~

Propertw | Value

Border Width

8]

Border Color

Border Alarm Hone hd

Figure 3.5-36 Border Properties
® Audio

The audio properties express the settings about audio meter information,
as shown in Figure 3.5-37:
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Audis Y
Property | Value
Output Audia ]
Audio Meter Size Level 3 -
Left Audio Chanmel numbers 2 -
Left Audio Seale Enshled
Fight Audic Channel mmbers |0 -
Fight Audic Scale Enabled ]

Figure 3.5-37 Audio Properties

B UMD/TALLY

The UMD/TALLY properties express the settings about audio meter
information, as shown in Figure 3.5-38:

MDD /TALLY s
Property | Value
Height 60
Left UMD Enahled

Left IMD Source Monitor Hame

Left UMD Text Color #FFFFFFEF

Left TMD Color

Left UMD Font Size 45

Right UMD Enshled L]

Fight TMD Source Source Wame

#FFFFFFEF

Right TMD Text Color

Fight TMD Color

Right TMD Font Size 45
Tally Enshled
Left Tally Color Red -
Right Tallw Colaor Green -

Figure 3.5-38 UMDI/TALLY Properties
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Appearance
Monitor Name |-- Monitor |Set the name for monitor
e Customer
Aspect Ratio [» 16:9 16:9 Set the aspect ratio for monitor
e 43
* Reserved: keep
the signal source
originally.
* Followed: the Set the display area ratio of the
Source Aspect . Preserv | . : .
. aspect ratio of the signal source in the monitor
Ratio ) : ed :
signal source will window.
be consistent with
the value of
monitor window.
Starting i 0 Set the starting x coordinate for
X-Coordinate the monitor, the unit is pixel.
Starting i 0 Set the starting y coordinate for
Y-Coordinate the monitor, the unit is pixel.
Width i 0 Se.t t_he \_Nldth for the monitor, the
unit is pixel.
Height i 0 Set th_e.hel.ght for the monitor,
the unit is pixel.
UMD  Display|Outside Monitor/ Outside Set_the PORNIEE 9f UMD and
. : . audio meter relatively to the
Mode Inside Monitor Monitor .
monitor frame.
View
Main Window |Yes/No No Set_ whether to display as the
main window.
Video Format Yes/No No Set whether to qllsplay video
Enable format for the monitor.
None/525160/625150/1 Set video format alarm, that is
080150/ using this format to compared
1080160/1080SF24/ with the format of the signal
1080P24/1080P25/ source designated to the current
Eormat 1080P30/1080P50/ monitor, if the resultis  uniform,
Detective 1080P60/720P24/ None it will not alarm and the video
720P25/720P30/ format displayed at the left
720P50/720P60/ corner of the monitor window is
1035160/525159.94/ in normal color, otherwise, it will
1080159.94/1080SF23 alarm by flashing the video
.98/ format displayed at the left
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1080P23.98/1080P29. corner of the monitor window
97/
1080P59.94/720P23.9
8/
720P29.97/720P59.94
Marker Enable |Yes/No No Set whethgr to display marker
for the monitor.
TC Enable Yes/No NoO Set whether to_ display time
code for the monitor.
Alarm
Video Loss Set whether tq dlspla_y video

) Yes/No No loss alarm information on

Display . .
monitor window.
Video  Freeze Set whether to_ dlsplay video

. Yes/No No freeze alarm information on
Display - :

monitor window.

. Set whether to display video
V|_deo Black Yes/No No black alarm information on
Display . .

monitor window.

. . Set whether to display audio
Audio High Yes/No No high alarm information on
Enable . .

monitor window.
Audio Low Set Whe;therto c_IlspIay audio I_ow
Yes/No No alarm information on monitor
Enable ;
window.
Audio Loss Set whether t(_) dlspla_y audio
Yes/No No loss alarm information on
Enable ) )
monitor window.
Border
Border Width 0~40 0 Set .the bprder width outside a
monitor window.
Border Color i 0 Set _the b.order color outside a
monitor window.
e None Set whether to alarm at the
e Source border of the monitor window,
Border Alarm Video&Audio None the alarm condition could be
Alarm Source Video&Audio Alarm, Left
e Left Tally Tally or Right Tally, the border
* Right Tally alarm will flash in red.
Audio
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Set whether to output audio
information. Specify the audio
source embedded in the signal
_ source of the selected monitor
Output Audio | Yes/No No window to the audio output
device, there will be an audio
icon *l| at the right corner of
the monitor window.
Audio Meter|Level 1/Level 2/Level Set the width of an audio
. Level 3
Size 3/Level 4 channel
Left Audio )
Channel 0/2/4/6/8 2 Set the audio channels
displayed as left audio meter.
Numbers
Left Audio Set whether to display scale in
Scale Enable Yes/No INO left audio meter.
Right Audio )
Channel 0/2/4/6/8 2 Set the audio channels
displayed as right audio meter.
Numbers
Right Audio Set whether to display scale in
Scale Enable e No right audio meter.
UMD/TALLY
Height 16~120 60 Set the height for UMD.
Left UMD Set whether to display the left
Enable Yes/No No UMD.
e Monitor Name
Left UMD|e Source Name Monitor [Set the input source for left
Source e Format Name |UMD.
e Format & Scale
Left UMD Text| 5 g 555 255255  [293:253 | gt the color for left UMD text.
Color , 153
Left UMD Color |0,0,0~255,255 255 0,51,25 |Set the color for left UMD
5 background.
;?Zﬁe UMD Font,5 100 45 Set the size for left UMD text.
Right UMD Set whether to display the right
Enable Yes/No Mg UMD.
¢  Monitor Name
Right UMD|e Source Name Monitor [Set the input source for right
Source e Format Name |UMD.
e Format & Scale
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1
'

Right UMD Text|, 1, 955,255,255 223253 | get the color for right UMD text.
Color ,153
Right UMD 0.0,0~255,255.255 51,153, |Set the color for right UMD
Color 0 background.
Al b 12~100 45 Set the size for right UMD text.
Font Size
Tally Enable Yes/No No Set whether to display the tally.
Left TALLY Red/Green/Yellow Red _Set_ the color for left Tally
Color indicator.
Right  TALLY Red/Green/Yellow Red _Set_ the color for right Tally
Color indicator.

B Tips

* For the numerical input-capable value items in the property table, the
system will provide the available input-capable value limitation, that is, after
click into the target cell of the value item, and docking for a second, it will
display a tip with the value range. For example: click the value cell of
Height in UMD/TALLY table, the cursor is docking in this cell, after a second,

it will display the available value range, as shown in Figure 3.5-39:

UMDITALLY -
Froperty | WValue
Height o

‘Iﬁ—‘lﬂ)l

Figure 3.5-39 Tip for Value Range

Left UMD Enabled |[]

2. Parameters for monitor
B Source Aspect Ratio

The Source Aspect Ratio parameter in video table is related with the
Aspect Ratio parameter in Appearance table.

Example 1: when the Aspect Ratio parameter is set as 16:9 and the
aspect ratio of the signal source is 4:3, if the Source Aspect Ratio
parameter is set as Reserved, the display is as shown in Figure 3.5-40:
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[] Monitor Window
|| Signal Source

Figure 3.5-40 Examplel for Source Aspect Ratio Set

Example 2: when the Aspect Ratio parameter is set as 16:9 and the
aspect ratio of the signal source is 4:3, if the Source Aspect Ratio
parameter is set as Followed, the display is as shown in Figure 3.5-41:

[ | Monitor Window
| | Signal Source

Figure 3.5-41 Example2 for Source Aspect Ratio Set

B Position of audio meter and UMD

Set the position of audio meter and UMD by the UMD Mode
parameter in Appearance table. If select Inside, the audio meter and
UMD will be displayed inside the Video Area of the monitor window,
otherwise, If select Outside, the audio meter and UMD will be
displayed outside the Video Area of the monitor window, the
comparison are as shown in Figure 3.5-42:

Qutside
Figure 3.5-42 Position of Audio Meter and UMD
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B Video Format

The video format of the input signal connected with the monitor window is
displayed at the top left corner of the monitor window. Select the
View—->Video Format Enabled property of the monitor window, the video
format is displayed as shown in the following figure.

mame : (TiManitor

SOurce

Figure 3.5-43 Video Format Dispaly

B Format Detective

The system will compare the format of the signal source with the Format
Detective property, and the result will conduct the video format alarm, and
reflect the alarm on UMD. When the comparison result is consistent, the
UMD characters are displayed in white, and when the comparison result is
inconsistent, the UMD characters are displayed in red as a warning.

For example: Set View—>Video Format Enabled property to be selected,
and set UMD/TALLY—>Left UMD Enabled property to be selected. Set
View—> Format Detective property to be 1080150, and set UMD/TALLY
- Left UMD Source property to be Format or Format&Scale, as shown
in Figure 3.5-43:

[ View o~ TMD,/TALLY .

Property | Value | FProperty | Value

Main Tindow I:‘ Height 60 ‘ A

Video Format Enahledt . Left UMD Enabled (

Format Detective 1030150 ‘v‘ Left IMD Source Format |V|

Figure 3.5-44 Format Detective

Then, if the format of the input signal is 720P50, it is inconsistent with the
Format Detective property, thus, the left UMD characters display 720P50
in red, as shown in , to prompt the inconsistency.

Hame '::1::|T|Tl:ll'|.' 0y

Figure 3.5-45 Format Detective Inconsistency
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B Frame

The illustration for video frame is as shown in Figure 3.5-46, the color is
set as RGB (200, 200, 24) by default, select and click the Border Color
parameter to pop up the color picker dialog box to set a color for the
frame.

La—Frame

Figure 3.5-46 lllustration for Video Frame

O Border Alarm

The border alarm is used to give an alarm in the border of the monitor
window with flash red color when meets the alarm condition,
meanwhile, the border width should not be 0.

The alarm condition for border alarm could be set as Source
Video&Audio Alarm, Left TALLY or Right TALLY. The Source
Video&Audio Alarm refers to the properties in monitor
property->Alarm list, including Video Loss Display, Video Freeze
Display, Video Black Display, Audio High Enable, Audio Low Enable,
Audio Loss Enable. The Left TALLY refers to the Left TALLY Source
item in SOURCE Tab. The Right TALLY refers to the Right TALLY
Source item in SOURCE Tab. Refer to “3.3.3 Set TALLY Source” for
the TALLY source settings.

For example: as shown in Figure 3.5-47, set the Border Alarm as
Source Video&Audio Alarm, then if the Video Loss Display
happened, the frame border will flash in red.
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(=1 A

Property

Value

A3

Video Loss D1...

K]

Video Freeze ...

Video Blaek D. ..

A3

A3

Audio High En. ..

&

Audio Low Enable

A3

budio Loss DIi...

Property | Value

Border Width |6

Border Color #FFCBCE18

¥ Border Alwm |Source Videofthudio Alarm |||, ..

Figure 3.5-47 Border Alarm

B Tips

* The frame for a monitor window is translucent, it will be overlapped over

the monitor window, and not affect its video area, you can set Border Width

and Border Color for the frame.

* Once you want to activate the border alarm function and set the Border
Alarm item to be Source Video&Audio Alarm, Left Tally, or Right Tally,
do not set the Border Width item to be 0, otherwise, it will not generate the

border alarm.

H Audio
O Audio Output

Designate the audio output, that is, the audio source connected with
the designated monitor will be output to an audio device.

Enable the Output Audio property, and specify the audio source
embedded in the connected signal source with the monitor window.
Click the target monitor window in the working area of Layout tab,
select its Audio>Output Audio property in property pane, as shown
in Figure 3.5-48, there will be audio icon at the top right corner of this
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monitor window, as shown in Figure 3.5-49:

fudia o,

Propertw | Value

Output Audic

Figure 3.5-48 Output Audio

Figure 3.5-49 Output Audio Icon

O Audio Meter Format

The parameters about audio meter appearance are listed in Audio
table, including: Audio Meter Size, Left Audio Channel numbers
and Right Audio Channel numbers, Left Audio Scale Enable and
Right Audio Scale Enable.

B Tips

The total number of the audio channels which are composed of Left Audio
Channel numbers and Right Audio Channel numbers in a monitor
window can't exceed 8. Thus, there should be only up to 8 audio channels
in a monitor window, and it displays Audio Meterl to Audio Meter4 from
left to right in sequence, each Audio Meter* contains two audio channels
defined in Source configuration, refer to "3.3.1 Set Audio Source" for the

details.

For example:

The Audio Meterl is set as Emb 1-2, and the Audio Meter2 is set as
Emb 3-4, as shown in Figure 3.5-50, and the audio meter parameters
for a monitor window are set, as shown in Figure 3.5-51:

115



1
Functionalities and Operations nsa

DEVICE | SOURCE | VIDEO FALL | LAYOUT |

1D S1gnal Name Mudio Meter 1 Audio Meter 2 Mudio Meter 3 budio Meter 4

1 Sourcell Emb 12 Emb 3—4 Emb 36 Emb 78

Figure 3.5-50 Audio Meter Setting

budio o~
Property | Value
Output Audio
Audio Meter Size Level 4 | ™ |[. ..
Left Audio Channel numbers |2 -l .

Left Audio Scale Enabled

Fight Audio Channel numhers |2 bl |

Fight Audic Scale Enabled

Figure 3.5-51 Audio Parameter Setting

Thus, the relationship of audio parameters setting and audio meter
setting are as shown in Figure 3.5-52:

Audio Meterl Audio Meter2
Emb 1-2 Emb 3-4

Figure 3.5-52 Relationship of Audio Parameters Setting and Audio
Meter Setting

m  UMD/Tally

The parameters about UMD are listed in UMD table, as shown in Figure
3.5-38.

O UMD Setting: UMD is displayed at the bottom of a monitor window,
as shown in Figure 3.5-53, you can assign the height for UMD, or
choose whether to display the left UMD or the right UMD
separately.
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i UMD Height

Left UMD Right UMD

Figure 3.5-53 UMD

O Color Setting: The color for UMD text and background can both be
customized. You can input the RGB value, or select one in its color
picker dialog box.

Select a color: click the color setting button, it will pop up the color
picker dialog box, as shown in Figure 3.5-54:

x

[ Seatches | nsv | usL | e [ ok |

| ]
) Recent:
| 0

||| ] ] o
|| 5 5 5 S

Preview

| 0K || Cancel || Beset |

Figure 3.5-54 Color Picker

Click in the color bar to select a color, and the color will show its effect

in the Preview area of this dialog box, click OK button to confirm the
selection.

It provides five tabs for color picker: Swatches, HSV, HSL, RGB,
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CMYK, click one tab to set a color.

O UMD Source: set Left UMD source and Right UMD source from
Monitor Name, Source Name, Format, Format & Scale.

TMD,/TALLY ~
Properts | Value
Height |auj
Left UMD Enahled
Left TMD Source Monitor Hame -1 .

Left IMD Text Color o

Source Mame

Left TMD Color Format
Format & Scale
Left IMD Font Size £

Figure 3.5-55 Set UMD Source

O TALLY Setting: set whether to display the left UMD and the right
UMD, and set the color for its text and background. For example:
choose the Tally Display item, and the tally indicators are as
shown in Figure 3.5-56:

Left Tally Right Tally

Figure 3.5-56 Tally

B Tips

* The prerequisite for Tally display is choosing any one of the Left UMD

Display or the Right UMD Display item, and then choose Tally Display, it

will show the tally indicators in the monitor window.
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* The display area of video window relates to the UMD Mode parameter. As

shown in Figure 3.5-42, if the UMD Mode parameter is set as Outside, you

can see the video area is enlarged.

3. Monitor Display

The monitor window displayed on the working area of Layout tab is as
shown in Figure 3.5-57:

Hame

I Locati

Figure 3.5-57 Position for a Monitor

The information listed in the monitor window from up to down contain:
Name, Location and Signal, the details are as below:

B Name: it displays the monitor name and its type information. The
default name is “Monitor” +’number’, each number will not be
repetitive.

B [ocation: the position parameters such as Horizontal Start Position,
Vertical Start Position, Width, Height, are showed in the monitor
window followed the key word Location in working area. The position
parameters will change with the position of the monitor window in
working area.

B Source: the signal source is showed in the monitor window followed
the key word Source in working area, as shown in Figure 3.5-58:

Hame |::1::|HIZII|.

Figure 3.5-58 Signal Source for a Monitor
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B Tips

*  The monitor window can be zoomed in a customized proportions, in 4:3 or

16:9, set in the Aspect Ratio parameter.

3.5.3.2 Clock/Date

The elements about date and time are contains the following types:
Analog Clock, Digital Clock and Digital Date. The details are as below:

1. Analog Clock
The properties of analog clock are as shown in Figure 3.5-59:

#nalog Clock ~

Property | Value

Starting Xoordinate |313

Starting YCoordinate |763
Width TO6
0ffzet (hour) ]

Figure 3.5-59 Analog Clock Properties

The property items for analog clock are listed in the following table:

Starting i 0 Set the starting x coordinate for the

X-Coordinate clock/date, the unit is pixel.

Starting i 0 Set the starting y coordinate for the

Y-Coordinate clock/date, the unit is pixel.

Width - - Set the size for analog clock

Offset(Hour) 0-24 0 Set the offse_t .for analog clock or digital
clock, the unit is hour.

The appearance of analog clock is as shown in Figure 3.5-60:
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Figure 3.5-60 Analog Clock

B Tips

* Particularly, when arranging the layout of analog clock, please abstain from

crossing among screens. For example, as shown in Figure 3.5-61, the
analog clock should not be arranged between 1-1 screen(connected with

Outputl) and 1-2 screen(connected with Output2).

1-1 -0 1-2

1-3 1-4

Figure 3.5-61 Analog Clock

2. Digital Clock
The properties of digital clock are as shown in Figure 3.5-62:
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1
—

Digital Clock

Propertw Value
Starting X Toordinate 1,275
Starting TCoordinate |00
Width 279
Height 225
Offzet (hour) 0
24~hour Clock

Figure 3.5-62 Digital Clock

The property items for digital clock are listed in the following table:

Starting i 0 Set the starting x coordinate for the

X-Coordinate clock/date, the unit is pixel.

Starting i 0 Set the starting y coordinate for the

Y-Coordinate clock/date, the unit is pixel.

Width - - Set the horizontal size for digital clock

Height - - Set the vertical size for digital clock
Set the offset for analog clock or

o) 0=zt 8 digital clock, the unit is hour.

24-hour Clock Yes/No Yes Set vyhether to display the digital
clock in 24-hour standard.

The appearance of digital clock is as shown in Figure 3.5-63:

Figure 3.5-63 Digital Clock

3. Digital Date

The properties of digital date are as shown in Figure 3.5-64:
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Digital Date ~

Propertw Value

Starting Xoordinate 1, 388

Starting Y Toordinate 921

Width 379
Height 162
Date Format vy mm—dd b

Figure 3.5-64 Digital Date

The property items for digital clock are listed in the following table:

Starting i 0 Set the starting x coordinate for the
X-Coordinate clock/date, the unit is pixel.
Starting i 0 Set the starting y coordinate for the
Y-Coordinate clock/date, the unit is pixel.
Width - - Set the horizontal size for digital clock
Height - - Set the vertical size for digital clock
*yyyy-m
m-dd
24-hour Clock  |°  9d-mm- \yyyy-mm g\ sequence for date display
yyyy  |-dd
e  mm-dd-
yyyy

The appearance of digital date is as shown in Figure 3.5-65:

Figure 3.5-65 Date

As above, all kinds of elements have the following two properties:

Horizontal Start Position: the starting x coordinate of the left corner of
the element window;

Vertical Start Position: the starting y coordinate of the left corner of
the element window.
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Take a monitor element for example, the coordinate of the left corner is as
shown in Figure 3.5-66:

[ DEVICE | SOURCE | VIDEO WALL [ LAYOUT |

A D ® B8 6| X =T a8cs

Figure 3.5-66 Left Corner for a Monitor Element

O Property Modification

The element will be changed right after you have modified its properties in
working area, and the property value will be changed right after you have

moved, stretched or zoomed the element, and the position and size of an

element will change with the properties, too.

B Tips

* The parameter value of the Starting X-Coordinate and the Starting

Y-Coordinate will determine the starting coordinate of an element window.

3.5.3.3 Audio Output Settings

You can designate a virtual audio output card to output the audio signal of
a designated signal source. The instructions are as below:
Step 1 Designate a Virtual Audio Output Card

In VIDEO WALL page->Wall Properties-Audio Output Card
As shown in Figure 3.5-67, create a new wall in VIDEO WALL page,
and designate an output card as the Audio Output Card.
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ﬁ%tput 1 :|[‘vEvice | source || vipEo waL [|avour | | Fall Properties N
Output 1-1 . 3
- = Vame Value
D Output 1-2 ./
D Output 1-3 Hame TallOl
D Output 174 Horizontal Screen lumber |6
[ output 2
[ output 3 5 Vertical Screen Mumber 6
[ output 4 I .
=7 Output 5 Horizontal Gap
] Gutput 6 Vertical Gap
3 output 7
[ output 8 Audio Output Card None -
3 output 9 Mone B
(Output 1
Dutput 2
Output 3 =
Output 4
(Output 5 |
(Output & o
| (Output 7 |
A w1

Figure 3.5-67 Designhate Audio Output Card

Step 2 Set Output Audio Type

In LAYOUT page->Model Prop- Output Audio Type

As shown in Figure 3.5-68, create a new layout in LAYOUT page,
then, set it audio type in Output Audio Type item or Analog Audio
item in Model properties pane.

Templates | i\ vevice | source | vioeo warL || zavowr || ‘| Element Prop | Meodel Prep
sedlix LINIo[ee[a[x]= T = ™ .

[ Input Source List -

¢ [ Tnput 1 : Property | Value
D Source 1-1
D Source 1-2
D Source 1-3
D Source 14
D Source 1-9
D Source 16 1
[y souree 1-7
D Source 1-8

& (7 [Enput 2|

o= Ij Input 3

o= Ij Input 4

o= Ij Input 5

o= Ij Input &

o= [ Input 7

o= Ij Input 3

o [ Tuput 9 Fall01-Layout0l :

o= [ Input 10 0

o= J Input 11 -l 945, 890

Layout Name Lawoutl

Transparency =)

Horizontal Splitter 2

Vertical Splitter 2

Output Audio Type Digital Audio hd

Analog Audio

Figure 3.5-68 Set Output Audio Type

Step 3 Designate Output Audio Source

In LAYOUT page—~>Element Prop—> Audio->Output Audio

Add and arrange monitor elements in a layout as your requirements,
and designate a signal source for each monitor element from the
Input Source List pane.

125



Functionalities and Operations nsaa

For example, as shown in Figure 3.5-69, select the target monitor
element in the layout, and click its Audio—>Output Audio property in
its Element Prop pane, then, there will be an audio output icon ¢

labeled at the top right corner of the monitor element. Thus, the
“Source1-1” will be output as the desired audio information.

Templatss | |("1EvICE | sowrcE | VIDED FALL [ LavoUT | | Element Frop | Model Prop
Signal List : H
el |y gele @) x|= 7 2] ~
[ Input Source List  |=| i = = e
& [JInput 1 3 . LY _ ‘ = —
Source 11 2 Property Value
[ souree 12 A Border width 2 |
O source 13 [T| :
D Source 14 : Border Colox #Pm!i|
A | : 1
[ source 15 | - b | Berder Mlem  [Home >l
[ souree 16 | o :
[ seuree 1- ' |0 -
[} source 1-8 *L Property THr -
o[ Input 2 ? |
Dutput Audi v L
o [ Input 3 utput Audie L
= ] Input 4 fndio Meter Size |Level 3 [w|l...
o[ Input 5
& 9 Tnput 6 Left Audic Cha .. |2 -
L ﬁ Input 7 A 2
: | o Lefr mudio s
o [ Input 8 : Th| ]| et tecte Bes &
o g Input 9 A1 Fal101 Layoutor A Right Awdicch [0 |v| .
o Input 10 a H |
& ] Input 11 =l: 840, 1410 H  Right Awdio Se. |[] =

Figure 3.5-69 Designate Output Audio Source

3.5.4 Elements Layout

It will introduce the application of the tools in model configuration, and give
some examples for impressive comprehension.

First, create a model, as shown in Figure 3.5-70, then, we will add some
elements to describe how to configure a layout for a model.

WALEPLAYOUT |

Layout Working Area ———oeviee—seuree
Layout Tool Bar—wio|¢|e @
None-Layout Area—

Layout Area

Tab of Layout Name w01 Layouto1 1355, 890

Figure 3.5-70 Working Area for Model Configuration
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O Layout Area: all elements will be added and displayed in this area, and
the physical video walls are corresponding to this area which is the light
green area in working area for model configuration.

O None-layout Area: no element can be added or displayed in this area,
and this area has no relationship with the physical video walls, it is the
canvas for the layout area and surrounding it.

B Tips

* The coordinates of the mouse cursor in layout area is displayed at the right

bottom corner of the working area for model configuration, as shown in
Figure 3.5-71.

DEVICE | SOURCE | VIDEO WALL | LAYOUT |

IDENEEE

__________________________________________________________________

|| wallLayouto1 | wall-Layouto2 |1329‘743

Figure 3.5-71 Coordinates for Mouse Cursor in Working Area for Model
Configuration

When the mouse cursor is in layout area, and select some element
windows, you can cooperate with tool buttons to activate the
corresponding commands, the following will introduce these tools.

3.5.4.1 Add an Element Window

Take the monitor element for example, add a monitor element in the layout
area, the others are the same.

B Use element tool to add an element window

Operation: click the monitor tool button [, the background of this tool

button is changing to in blue| [/, now you have chosen monitor tool.
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O Element with any size: click the left mouse button to decide the
starting coordinate of the top left corner, hold the button down and
draw a rectangle, then release the left mouse button, it will add a
monitor window, as shown in Figure 3.5-72:

Figure 3.5-72 Add a Monitor Window

O Element with accurate size: first use the monitor tool 1| to add

an element window, then click to select the element window in
working area, it will display its properties about size and position in
its Element Prop pane, modify these properties values to
determine the accurate size and position for this window in video
wall.

[(pEvice | source | vipeo WAL | Lavour |
DEDNEEEERERE | Hons tor .

Appearance N

;érElent Frop ruodel Prop

[»

Property Value

Monitor Wame Moni tor

Aspect Ratio 16:9 ...

Source Aspect Ratio |Reserved b

Starting XCoordinatefl02

Starting YCoordinate|35

Fidth | G

Height 433

UMD Display Mode Outside Momitor | |[...

Figure 3.5-73 Position Properties for a Monitor Window

B Tips

* After you have selected an element tool button, press and drag to add

element windows consecutively, you will add the same kind of element until

you select another element tool.
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* Especially, the outline of an analog clock is a square, the ratio of the width
and the height is 1.

* Itis recommended not to overlap the element windows on a video wall, in
case of the display effects, there will be an icon& on each overlapped
element window as prompt in layout area, and there will be a tip at the

mouse cursor on the overlapped elements.

O Use split tool to add an element window

Especially, after add a monitor window, click split monitor tool button gm

to divide the selected monitor into the desired numbers, refer to "3.5.4.3
Fill and Split" for details.

3.5.4.2 Select an Element Window

You can select only one element window, or multiple element windows, or
all of the element windows in working area at a time.

BTips

* Select tool: click the select tool button in the edit tool bar k |, it will change

its background color as| k | when it is chosen.

* Mouse cursor: after select a tool button, click in the layout area, and it will
focus the mouse cursor into the layout area, make sure you have move the

mouse cursor into the layout area before you do the selection operation.

B Select a single element window: click the Select tool k | in edit tool

bar, and click on your desired element window, it will show a red
rectangle surrounding the selected element window, and there are
adjusting handles(white rectangle) on the element window, thus this
element window is selected, as shown in Figure 3.5-74
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Hame ':1 ::'H-:-nit-:-r

Figure 3.5-74 Single Selected Element Window

B Select multiple element windows: click Select tool k | in edit tool

bar, click on a desired element window, then press Ctrl Key down, and
click on the other desired element windows, thus to select multiple
element windows. Or, after click the Select tool, press the left mouse
button down, drag and draw a big rectangle to circle all the other
desired element windows, release the left mouse button and these
element windows are selected, as shown in Figure 3.5-75:

Figure 3.5-75 Multiple Selected Element Windows

B Select all element windows: click Select| k @ tool in edit tool bar,

click in layout area to move the mouse cursor, press Ctrl+A key
combination, or select Edit->Select All menu command, thus, all
element windows in working area are selected.

B Cancel Selection: when there are selected element windows in

working area, click in the blank position in layout area, or draw another
element window, the selection will be canceled.

3.5.4.3 Fill and Split

B Magic Wand

It provides a magic wand tool to full fill the blank area between the existed

element windows in layout area. Click Magic wand

2

tool button, and

click at a blank area, it will add a most large monitor window to full fill the

blank.
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It is used to full fill the blank area in video wall.

B Split

Use element tools to add multiple element windows, as shown in Part Ain
Figure 3.5-77. Or, drawing a big enough element window, select it and
click Split tool button, it will pop up a setting window, input the split
parameters, as shown in Figure 3.5-76, then it will be split into a few small
windows with the same size, as shown in Part B in Figure 3.5-77:

Horizontal E Vertical |EE

L] Align left & top. - Align Center.

0K Cancel

Figure 3.5-76 Split Setting

Figure 3.5-77 Split the Selected Element Window

B Magic Wand+ Split

In a model, you can use the magic wand tool to add a large enough
monitor window which is not overlapped with the other monitors
surrounding it, then use the split tool to divide the large monitor into a few
desired small monitors with the same size, thus to make good use of the
blank area.

For example: there is a Monitor 0 in a model, as shown in ,please use the
magic wand and split tool to add a 2*4 equal small monitors beside it, the
operations are as below:
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Figure 3.5-78 Add a Monitor Window

Step 1 Add a large enough monitor

Click the magic wand tool ¢ , move the mouse cursor into the layout area,

and click at the right blank area besides Monitor 1, then it will a monitor in
red rectangle, as shown in Figure 3.5-79:

Figure 3.5-79 Fill the Blank Area

Step 2 Divide the monitor

Click the Split tool g, and input the divided parameters as shown in
Figure 3.5-80:
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Horizontal |EE Vertiecal |EE

. Align left & top. i Align Center.

0K

Cancel

Figure 3.5-80 Split Setting

Click OK to confirm the split parameters, then the monitor is divided into
eight small monitors with the same size, as shown in Figure 3.5-81:

Figure 3.5-81 Split Windows

B Tips

* Usually, when need to add equal sized monitors, or fill the blank area with

monitor automatically, use the magic wand tool or split tool.

3.5.4.4 Adjust Window

1. Adjust the Window Size

The element added in layout area is display as a rectangle window, and
the size of the window is decided by the height and width of the element.

B Stretch an element: select an element, and move the mouse cursor to
the edge of the window, the cursor will change its shape into a double
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-headed arrow like this: #=&, E or¥a, then press the left mouse button
down, and drag it to be zoomed in or zoomed out, thus to change the
size of the window, as shown in Figure 3.5-82:

Figure 3.5-82 Stretch the Window

Stretch a window to change its height and width, or modify the values of
the properties on height and width to change the size.

B Tips

* The ratio of the element window can be set at any rate, 4:3, or 16:9, set the

Aspect Ratio property.

For example: the function of the snap tool| €  using when changing the
size of a monitor window.

First, click the Snap tool € |, it will change its background color to label the
shap as activated.

Then, when you move the mouse cursor to the left edge of a monitor
window, the mouse cursor is changed into a double-headed arrow =g,
drag towards left to change the size of the window, and you can see there
is a ruler with red dotted line to align with the grid lines, as shown in
Figure 3.5-83:
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( DEVICE |’5{:~UR{:E rUIDEDWALL |’LM{:~UT
kAL ® =2 E X =T a8lcs

| |
Mame : (1

_m Source: 5

Figure 3.5-83 Snap Ruler

2. Adjust the Window Position

The element added in layout area is display as a rectangle window, and
the position of the window is decided by the Horizontal Start Position
and the Vertical Start Position of the element. Move the element window
as the following methods:

B Method 1: select an element window, press the left mouse button
down, and drag it to the desired position, and the coordinate of the
window will be changed.

B Method 2: modify the values of the Horizontal Start Position property
and the Vertical Start Position property of the element, then the
position will be changed.

BTips

* The Snap tool is very helpful when moving the element window and

aligning it to the grid lines on the video wall.

3.5.4.5 Common Edit Operation

1. Copy and Paste for Element

You could copy and paste an element in working area in Model
configuration window. The operations are as below:

Click to select an element window as the original one, and click Copy tool
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button| fg | in tool bar, or select Edit->Copy menu command, then click

Paste tool button| [ |, or select Edit>Paste menu command, thus, the

new element window will be pasted at the lower right direction whose
coordinate of the top left corner offset (100,100) relative to the original
element window, and complete the copy and paste.

For example: the top left corner of the original monitor window is (200,0),
copy it, and paste it, the top left corner of the new monitor is (300,100), as
shown in Figure 3.5-84, the new one is at the lower right direction of the
original one, and the distance is (100,100).

Mame : (i anitor

H arn I:l_ AR ihir
(= nitar

Figure 3.5-84 Copy and Paste

If you do the paste operation more than one times, you can see the new
monitors are overlapping the last one, and move the lower right direction,
each time (100,100) as a step, as shown in Figure 3.5-85:

H arna - Fihlnn ihir
I T T i
s

Figure 3.5-85 Multiple Paste Operations

2. Delete Element
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You can delete element by the following methods:

B  Method 1: Use the Delete command. Click Delete button i | in tool

bar, or select Edit—> Delete menu command, it will delete the selected
elements in working area.

B  Method 2: Use the Clear command. Click Clear button s | in tool bar,

or select Edit> Clear menu command, it will delete all elements
whether selected or not in working area.

B Method 3: Use the key. Click to select an element or more, then press
Delete key to delete the selected element.

B Tips

* Use Delete key to delete the selected elements.

* All of the above deletion can be canceled by Undo |# command.

3. Copy Size and Copy Properties
B Copy Size

Copy the size of an element window to another one.
Operation: the size of monitor A and monitor B are as shown in

Figure 3.5-86, select monitor A, and click the Copy Size tool sl

then click the target monitor B whose size will be as big as monitor A's,
the new size of monitor B is as shown in Figure 3.5-87:

Marme : (1 hanitar

Saure

Figure 3.5-86 Select Monitor A
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Figure 3.5-87 Monitor B with the New Size

The value of Height and Width of monitor A and monitor B are the
same.

B Copy Properties

Copy the properties of an element window to another one.

Operation: the properties of monitor A and monitor B are as shown in
Figure 3.5-88:

Monitor - Monitor -
Appearance - = Appearance - el
Property Value Property Value
Monitor Name Monitor [] L Monitor Name Monitor -] L
Aspect Ratio 16:9 Al Aspect Ratio 4:3 || ..
Source Aspect Ratio Reserved v/l -] | Source Aspect Ratio Reserved - -] |
Starting X-Coordinate 128 Starting X-Coordinate 1,466
Starting Y-Coordinate 128 Starting Y-Coordinate 128
Width 972 Width 872
Height 547 Height 504|
View - View -
Property | Value Property ‘ Value
Video Format Enablad ] VideoFomatEnabled | | ]
Format Detective Hone | - ‘ Format Detective None ‘ - |
Marker Enabled Marker Enabled O
TC Enabled TC Enabled Ol

Figure 3.5-88 Properties of Monitor A and Monitor B-Before Copy
Properties

Select monitor A, and click the Copy Properties tool T , then click

the target monitor, the properties except Horizontal Start Position,
Vertical Start Position, Width and Height will all be copied to
monitor B, the new monitor B is as shown in Figure 3.5-89:
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Monitor - Monitor -
Appearance - = Appearance - =l
Property Value Property Value
Monitor Name Monitor -] L Monitor Name Monitor [ L
Aspect Ratio 16:9 || Aspect Ratio 4:3 -
Source Aspect Ratio Reserved il -1 Source Aspect Ratio Reserved > -] |
Starting X-Coordinate 128 Starting X-Coordinate 1,466
Starting Y-Coordinate 128 Starting Y-Coordinate 128
Width 972 Width 672
Height 547 Height 504|
View - View -
Property | Value Property Value
Video Format Enabled 7 _;|;1;u_|_=;r_n;;1_E_n;;l_e_d“ ______________ [ ]
Format Detective Hone |v‘ Format Detective None ‘vi
Marker Enabled Marker Enabled
TC Enabled TC Enabled i

Figure 3.5-89 Properties of Monitor A and Monitor B-After Copy
Properties

B Tips

* Use Delete key to delete the selected elements.

* The properties for Copy Size command are the Width property and the
Height property.

* The properties for Copy Properties command are the properties except
Horizontal Start Position, Vertical Start Position, Width and Height.

3.5.4.6 Align Window

It provides some align commands for deal with the position relationship of
element windows, such as Align Left, Align Right, Align Top, Align
Bottom, Align Vertical Center, Align Horizontal Center, Horizontal
Docking, Vertical Docking, Horizontal Equal Spacing, Vertical Equal
Spacing, Equal Width, Equal Height.

It will give some examples for these commands as below:

1. Align

The common align commands: Align Left, Align Right, Align Top, and
Align Bottom are all based on the edge of the element window. Take the
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Align Left command for example to express how to align element

windows.

For example: there are three monitor windows which are labeled as A, B
and C in a model. Click Select tool k |, press the left button down and

drag a rectangle to involve all of the three windows, as shown in Figure
3.5-90.

Figure 3.5-90 Select the Elements to Be Aligned

Then, click the Align Left tool =

, they will align to the most left edge of

all these three monitors, as shown in Figure 3.5-91:

Figure 3.5-91 Align Left
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2. Center

There are Align Vertical Center command and Align Horizontal Center
command which will align based on the center of the element windows. Do
Align Vertical Center command, and all of the selected element windows
will align in a line vertically.

For example: these three monitors are aligned vertical center, as shown in
Figure 3.5-92:

Figure 3.5-92 Align Vertical Center

For example: These three monitors are aligned Horizontal center, as
shown in Figure 3.5-93:

source : Signal 1™

Figure 3.5-93 Align Horizontal Center

3. Remove gaps

There are Horizontal Docking command and Vertical Docking
command which will remove the gap between every two adjacent element
windows in horizontal direction and vertical direction separately.
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For example: there are three monitor windows which are labeled as A, B

and C in a model. Click the select tool

R

, press the left button down and

drag a rectangle to involve all of the three windows, as shown in Figure

3.5-94:

Mame : {1ionitor

Figure 3.5-94 Select Elements

4

Click Horizontal Docking tool

, it will remove the horizontal gaps

between the three elements, and it will arrange the elements from left to
right based on the most left edge of these elements, as shown in Figure

3.5-95:

Figure 3.5-95 Horizontal Docking Elements
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Click Vertical Docking tool ¥ |, it will remove the vertical gaps between

the three elements, and it will arrange the elements from top to bottom
based on the most top edge of these elements, as shown in Figure
3.5-96:

Figure 3.5-96 Vertical Docking Elements

B Tips

* It does not support to overlap elements in a video wall, so use these align

tool to arrange their positions.

4. Equal Distance

There are Horizontal Equal Spacing command and Vertical Equal
Spacing command which will equal the center point distance between
every two adjacent element windows in horizontal direction and vertical
direction separately.

B Horizontal Equal Spacing: reallocate the new horizontal center for
the element windows which is between the most left element window
and the most right element window of the entire selected element
windows. Thus, the average distance between every two center points
of the adjacent selected elements is the same.

B Vertical Equal Spacing: reallocate the new vertical center for the
element windows which is between the most top element window and
the most bottom element window of the entire selected element
windows. Thus, the average distance between every two center points
of the adjacent selected elements is the same.
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For Example: there are four monitor windows, as shown in Figure 3.5-97:

45 540,700
al 1

1
1
1
1
1
1
1
1
1
1
1
1
L
1
1
1
1
1
1
1
1
1
1
1
1
1

Figure 3.5-97 Select Elements

Select them, and click Horizontal Equal Spacing button

, the new

position for them are as shown in Figure 3.5-98, the horizontal distance
between every two center points of the adjacent selected elements is the

same.

Figure 3.5-98 Horizontal Equal Spacing Elements

Or, click Vertical Equal Spacing button| = |, the new position for them are
as shown in Figure 3.5-99, the vertical distance between every two center

points of the adjacent selected elements is the same.
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Source ;

Figure 3.5-99 Vertical Equal Spacing Elements

5. Equal Width/Height

There are Equal Width command and Equal Height command to
reassign the Width and the Height between element windows separately.

B Equal Width: assign the average width to each selected element
window. The average width is equal to the result that is the total width
from the left edge to the right edge of the entire selected elements
divided by the number of the selected elements.

B Equal Height: assign the average height to each selected element
window. The average height is equal to the result that is the total height
from the top edge to the bottom edge of the entire selected elements
divided by the number of the selected elements.

Examplel: there are three monitor windows, the total width of these
selected elements is labeled by the double-headed arrow, as shown in
Figure 3.5-100:

Marme {1 itar
60, 540]

Figure 3.5-100 Total Width of the Selected Elements
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Click the Equal Width tool |||, the width for each element is as shown in

Figure 3.5-101, and the starting y coordinate for A, B, C is 60, 335, 780
separately, the same as their originals.

Lm

Figure 3.5-101 Equal Width

Example2: there are three monitor windows, the total height of these
selected elements is labeled by the double-headed arrow, as shown in
Figure 3.5-102:

Figure 3.5-102 Total Height of the Selected Elements

Click the Equal Width tool| I |, the width for each element is as shown in

Figure 3.5-101, and the starting y coordinate for A, B, C is 320, 1410, 435
separately, the same as their originals.
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Figure 3.5-103 Equal Height

B Tips

* The aspect ratio of the element windows which are before and after equal

width or equal height operation are the same.

6. Overlap

When the monitor windows overlap, there will be an overlap icon& on
each overlapped monitor window, and move the mouse cursor on the
overlapped monitor window, there will a tip to prompt which monitor is
overlapped with the cursor location one.

For example: as shown in Figure 3.5-104, monitor A is overlapped with
monitor B, and monitor C is not overlapped, so there is overlap icon on
monitor A and monitor B.

Overlaving:
i1 Mand tor

Figure 3.5-104 Monitor Overlap
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3.6 Other Functions

It will introduce some assistant function in AURORA, such as Import and
Export, Restore Factory Default, Device Information, Change
Authorization Code and Language Selection.

3.6.1 Import and Export

Select File=>Import/Export menu command to copy or backup the data
on video wall, model and screens.

3.6.1.1 Export

You can select Export command to export all of the project data, or only
the Layout data, the instructions are as below.

Select File>Export menu command, it will pop up the export dialog box,
select the export type, as shown in Figure 3.6-1:

x
Export 4ll Export Layout
Cancel

Figure 3.6-1 Select Export Type

1. Export All

Click Export All button to export all of the project data, it will prompt the
export directory dialog box, as shown in Figure 3.6-2:
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Save In: ||j My Documents ‘v| E

[} 1.0see

File HName: || |

Files of Type: |*.0see ‘ - ‘
Export Cancel

Figure 3.6-2 Export Dialog Box

Select an export file, and click Export button, it will execute the export
operation. If the name of the export file is already existed, it will pop up the
prompt, as shown in Figure 3.6-3:

x|
? File alread}' ex1sts, confirm overwrite and continue?
ies L

Figure 3.6-3 Prompt for Reduplicated File

If the export operation is successful, it will pop up a successful prompt,
such as shown in Figure 3.6-4, click OK to confirm it.

x4
@ Export Successfullw!

0K

Figure 3.6-4 Prompt for Successful Export

2. Export Layout

Click Export Layout button to export the layout data, it will prompt the
export directory dialog box, as shown in Figure 3.6-5:
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x|
keleo Hame Window Count | Current Model
]| videa 7all: walloi ~
D Layout0l | & | o
| O | Layout02 | 5 | jif |
| O | Layout03 | 4 | i |
| O | Layout04 | 1 | To |

Previes:

Figure 3.6-5 Export Layout Dialog Box

Click the selection box in the Select column to choose the export layout,
and check it in the Preview window, you can select one or more layouts to

export.

i

Selec Vame Window Count | Current Model
1| videa ¥all: Walloi ~
O Layout0l 5 i
Layout02 5 Ha |‘
O Layout03 4 jif |
| O | Layout04 1 o |

Preview:

Figure 3.6-6 Select a Layout Dialog Box

Click Export button to confirm the selection, set the export directory, and
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click Export button, it will execute the export operation.
3.6.1.2 Import

Select File=>Import menu command, it will pop up the Import dialog box,
as shown in Figure 3.6-7:

Import [x]

Select ﬁle:‘ ‘ ‘ Browse... ‘

Figure 3.6-7 Import Dialog Box

Click Browse button to select a file to import, it will pop up the import
dialog box, as shown in Figure 3.6-8, click Open button to confirm the

selection.
l]pen
Look In: ||j My Documents |V| E
[} 1.0see
File Name: || |
Files of Type: |*.0see | - ‘
Open Cancel

Figure 3.6-8 Import Dialog Box
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If the file contains the project data, it will import all project data, and if the
file only contains the layout data, it will prompt for a dialog for layout

selection.

Functionalities and Operations

1. Import All

It will show a caution for importing operation, as shown in Figure 3.6-9.
Click Import button to start the import operation, and the import
information will list at the center of the import dialog box.

[<]

Import

Select File: |D\My Documents\1.osee | | Browse... ‘

Import data will cover all equipment, please careful introduction!
It will take Several minutes,please be patient and not cut off the
power supply or close this window.

Figure 3.6-9 Prompt for Overwrite

It will pop up a successful prompt after completing import. Otherwise, click
Close button to cancel the import operation.
2. Import Layout

It will show a caution for importing operation, as shown in Figure 3.6-10.
Choose layout at the left list, and check it in the Preview window below,
select the target wall at the right list, then click Import button to start the

import operation.
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B Inport x|
Select File: |CZ \Users\Documents\l. osee | Erowse. .. |
Import Layout: Choose Layout at left side impert to the Wall at right side.

| D Layoutt@ [=3 wallon

[} Layoutoa [} Layeuto1
D Layout(2
D Layout03
D Layout(4

Preview: Preview:

Figure 3.6-10 Import Layout Dialog Box

B Tips

* If the name of the selected layout is as the same as the existed one in the

target project, there will be a suffix “-Impt” added at the end of the imported

new one, the old one will not be covered.

3.6.2 Restore Factory Default

Use the Restore Factory Default command to restore the factory defaults.

Click Help—~> Restore Factory Default menu command, it will pop up the
prompt for confirming whether to restore the factory defaults, as shown in
Figure 3.6-11.

Click Yes to restore the factory defaults, then restart the multi-image
processor after one minutes at least. Click No to cancel the restore
operation.
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E
? Reset w1ll lost all configurations! Are wou sure?
Yes Ha

Figure 3.6-11 Prompt for Restore Factory Default

B Tips

* The Help—> Restore Factory Default operation will not restore the default

IP address, but you could restore the default IP address by short-circuit an
electronic element in the control module of the multi-image processor.

Refer to the manual for the corresponding multi-image processor.

3.6.3 Device Information

Use the device information command to check the devices in the project.

Click Help—~> Device Information menu command, it will pop up the
device information list, as shown in Figure 3.6-12, including device
information, device name, version and so on.

]]ev:i.t:e Information il
Battery Status: Normal FanState Status: Normal Temperature State: Low

Authorization Status: 16screendout Authorization Code: 00110524

Hame Slaot Ho. Version
Output Card AFM Hone 2.0
Cross Card ARM Hone 2.5
Cross Card FPGA Hone 3.0
Output Card FPGAL None 3.18
Output Card FPGA2 Hone 3.8

Figure 3.6-12 Device Information List
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3.6.4 Language

Use Language command to switch language between English and
Chinese in the software.

Click Help~> Language menu command, it will show the drop down list for
language selection: Chinese, English, choose one, and the software
language will be changed to the corresponding language item.

3.6.5 Change Authorization Code

Use the Change Authorization Code command to change the
authorization code of the multi-image processor, thus to satisfy different
requirement for device display capacity.

Click Help—~> Change Authorization Code menu command, it will pop up
Change Authorization Code dialog box, as shown in Figure 3.6-13, input a
code in the Enter Authorization Code field, and click OK to confirm the
modification.

Change Aunthorization Code EI

Enter Authorization Code :

0K Cancel

Figure 3.6-13 Change Authorization Code Dialog Box

Then, it will pop up a warning for authorization code changing, as shown
in Figure 3.6-14, click Yes, and you should keep the multi-image
processor being powered up at least two minutes during the authorization
code changing, thus to complete saving the changes.

X

IE‘ Change Authorization Code need keep pover om . All Unzaved w1ll mizzing Change now?

Yes e

Figure 3.6-14 Prompt for Change Authorization Code

A Yvyarninnm
SAA“IBRERIRRL"S

e Make sure you have entered a valid authorization code to the device,
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otherwise the device may not work normally.

3.6.6 Hardware Update

The Hardware Update command contains two items: Zip File and Update,
as shown in Figure 3.6-15:

Help|

Restore Factory Default

Tevice Information

Language b

Change Authorization Code

Hardware Update B Zip File. .
About. .. IUpdate

Figure 3.6-15 Hardware Update

Aurora software supports update operation only with the file of
oseeupdate type. For we offer the update file with the bin type, so you
should use the Zip File command to convert the update file from bin type
to oseeupdate type.

1. Zip File

Use Zip File command to convert the update file from bin type to
oseeupdate type. The relationships between the element type and the file
type are as shown in the following table, the instructions are as below:

CrossCard ARM Aurora_CrossCard_ARM*

Output ARM Aurora_OutputCard_ARM*

Output FPGA Aurora_OutputCard_FPGA*

CrossCard FPGA Aurora_InputCard_FPGA*
Step 1 Zip File

Click Help—~> Hardware Update-> Zip File menu command, it will pop up
Zip File dialog box, as shown in Figure 3.6-16, click the corresponding
button to select the zip file type. For example, zip the Output ARM file.
Click Output ARM button, it will pop up the Select dialog box, as shown in
Figure 3.6-17:

156



1
nsn Functionalities and Operations
EiZip Files. .. x|

| CrossCard_ AFM |

| Output_AFM |

| Output_FPGA |

| CrossCard FPGA |

Package H Close |

Figure 3.6-16 Zip File Dialog Box

Look In: ||j My Documents |V‘ E

[ Aurora_OutputCard_ARM_v2.0.2015.11.05.tar.gz.bin |

File Hame: |Aurora_OutputCard_ARM_vQ.U.Zm 5.11.05.tar.gz bin |

Files of Type: |Aurora_0umm{:ard_ARM* | = ‘

|Select||Canoel‘

Figure 3.6-17 Select a Zip File Dialog Box

Step 2 Zip and Save

Select the target file and click Select button to confirm the selection, the
file is loaded to the Zip file dialog box, as shown in Figure 3.6-18. Click
Package button to confirm the package operation, it will prompt the Save
dialog box, as shown in Figure 3.6-19:
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x

CrossCard_AFM |

Output_ARM |

D:\My Documentshburora OutputCard AFM +2.0.2015.11.05. tar. g=. bin

Output_FPGA |

CrossCard FPGA |

Package ‘ | Close |

Figure 3.6-18 Load the Zip File

Input the file name, and appoint the save directory, you can use the
default one. The file type is oseeupdate, that is the file suffix is
“.oseeupdate”, click Save button to confirm the save operation, it will pop
up a prompt for saving successfully, as shown in Figure 3.6-20.

FiSave
Save In: ||j My Documents |v‘ E
|D aurora.oseeupdate |
File Hame: |aurora.oseeupda.te |
Files of Type: | JLOseeupdate | - ‘

[Come ][ |

Figure 3.6-19 Save the Zip File

Tip

@ Save Successfully.

OK

Figure 3.6-20 Prompt for Save Successfully

2. Update
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Aurora software supports update operation only with the file of
oseeupdate type. The update file has been converted to be oseeupdate
type refer to the above Zip File operation. The update operations are as
following instructions:

Step 1 Select the update file

Click Help~> Hardware Update—> Update menu command, it will pop up
upgrade dialog box, as shown in Figure 3.6-21, click the Select upgrade
package button to select an update file, it will pop up the Open dialog box,
as shown in Figure 3.6-22, click Open button to load this file.

Au.rorall:'nl]l] Hardware upgrade interface ﬂ

Patch

| Select upgrade package:

Figure 3.6-21 Update Dialog Box

o
Look In: ‘Ij Documents |V‘ E

D AUF OF 4. oseeupdate

File Mame: ” |

Files of Type: |. osecupdate |v|

| Open || Cancel |

Figure 3.6-22 Save Dialog Box
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Step 2 Update and Restart

It will display the name of the update file at the right side of the Select
upgrade package button, as shown in Figure 3.6-23, then click Update
button to confirm the upgrade operation, it will display the process of the
update, as shown in Figure 3.6-24:

Auroralﬁl]ﬂ Hardware upgrade interface ﬂ

| Select upgrade pac]{agei

aurora. oseeupdate

Output_AFM
Outputll

Figure 3.6-23 Update Dialog Box

Au.rorall:'nl]l] Hardware upgrade interface ﬂ

| Select upgrade package:

aurora. oseeupdate

Output_AFM
Outputll

Output ARM BeginUpdata
Prepare For Write

Erase the old version
Write begin
auroralpdata write(%
auroralpdata writel %o
auroralpdata write2%
auroralpdata write3%
auroralpdata writed%s
auroralpdata write5%
auroralpdata write6%
auroralpdata write7%
auroralpdata write8%
auroralpdata write®%o

Figure 3.6-24 Update Process
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After update operation has completed, it will pop up a restart prompt as
shown in Figure 3.6-25, click OK button, and please restart your device
manually to effect the update operation.

Aurorall:'il]l] Hardware unpgrade interface l

| Select upgrade package: |aurora.oseeupdate

Output
Output0

P
g
g
[
;
B
3
q
g
E
| »

auroraUpdata write88%

auroraUpdata write89%

auroraUpdata write90%

auroraUpdata write91%

aworalipdata wrte92%
auroraUpdata write93%

auroraUpdata write94% Please restart your device
auroraUpdata write93%

auroraUpdata write96%

auroraUpdata write97%

auroraUpdata write98%

auroraUpdata write99%

auroraUpdata write100%

Output ARM Finish |

(]

Figure 3.6-25 Restart Prompt

B Tips

* Itis recommended that the connection between the control computer and

the target multi-image processor should be straight through connected.

* When update the multi-image processor, please follow these steps: First,
power off the device and restart it. Second, execute the Zip File command
and the Update command in sequence. At last, after the prompt of
updating completed, power off the device and restart it again to affect the

update.

3.6.7 About

Use the About command to display the basic and version information
about this software.

Click Help~> About menu command, it will pop up the version information
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dialog box, as shown in Figure 3.6-26, click Close button to close this
dialog box.

I x|

G & Do (oo Tl Bl Bl
Web—site : http://wew. osee—dig com
= 2015 0SEE TECHNOLOGY CO.,LTD. All Rights Reserved

Version : Mroa 3.0(Build:201701041620)

Figure 3.6-26 Update Dialog Box

3.7 Online Control

Click Control button| 5| in the right bottom of the status bar to enter the

online control editor, it will display the online controller interface, as shown
in Figure 3.7-1:

[EAurora Bulti-image System Controller (o] x|

#)[+)[@|fmmT]|@][][ %] @] [4] o [e
SignalSource Layout

Signal Signal Signal Signal

Signal Signal Signal Signal

Signal Signal

# 0nline  192.168.1.70
Figure 3.7-1 Online Controller
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3.7.1 Device Connect

In online controller interface, press Connect button # | in the toolbar to
set up the connection between the control computer and the target
multi-image controller, and use the Disconnect button| ¥ | to cut down

the connection.

1. Connect

Click CONNECT button| # | in tool bar, it will pop up the Device Connect

dialog box. Set the network card, selecting a target connecting destination,
and set up the connection, it will display the keyword Online and the IP
address of the multi-image controller in the status bar.

2. Disconnect

Click DISCONNECT button| ¥ | in tool bar, it will cut off the connection

with the current multi-image controller, and it will display the keyword
Offline in the status bar.

The operations are almost the same as in the configuration editor, please
refer to “2.2.2 Device Connection” for the details.

3.7.2 Template Switch

In online controller interface, press the Layout tab, it will list the
thumbnails of all templates in the layout pane, as shown in Figure 3.7-2:

’,461@@7% | ———— (@ [}

g A
10 2

3

1
- - . A
-- Signal Signal

# online : 192.168.1.70

Figure 3.7-2 Online Controller
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Click the any one of the template in the Layout pane, it will display in the
right preview area of the Online controller, thus to preview the display
effect of the current selected template.

The current used template on the display screen is highlighted in the
Layout pane, and there is a keyword Playing at the top right corner of the
template thumbnail in the Layout pane, as shown in Figure 3.7-3:

|/ S1gnalSource |/ Lavout

Figure 3.7-3 Template on Playing

B Switch Template Operation

Select the target template in the Layout pane, then double-click it or click

the Display Current Layout button

O

in the toolbar, it will be applied to

the display screen, and pop up the prompt as shown in Figure 3.7-4, click

OK button to confirm the completion
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Tip

L Lavout changed.

0K

Figure 3.7-4 Switch a Template

3.7.3 Signal Source Switch

In online controller interface, press the Signal Source tab, it will display
the signal sources list in this pane, as shown in Figure 3.7-5:

l/SiglalSnurce rLa}'nut |

[ source
D Sourcell
|j| Sourcel2
D Sourcel3
|j| Sourceld
D Sourcels
|j| Sourcels
D Sourcel?
|j| Sourceld
D Sourceld
|j| Sourcelld
D Sourcell
|j| Sourcell

D Sourceld
|j| Sourceld

D Sourceld

|j| Sourceld

Figure 3.7-5 SignalSource List

Click the target monitor window in the display area at the right part of the
online controller interface, and drag a signal source from the signal source
tree to this monitor and hold on, release the left mouse button, then the
signal source of this monitor will be replaced by the new one.

3.7.4 Image Zoom In/Out

In online controller interface, you can zoom in or zoom out the image
displayed at the right part of the online controller interface, do as follows to
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realize this function.

B Zoom In/Out by Shortcut Button

Click the image size control buttons in the toolbar at the top line of the
online controller, the functionality of each button is listed in the following
table:

Zoom In Q It is used to zoom in the display area of the monitor
in working area.

It is used to zoom out the display area of the

Zoom Out Q monitor in working area.

Fitting With It is used to zoom the display area of the monitor to
Screen fitting with screen.

It is used to control the display ration of the monitor,
Ratio Custom |« |(providing these ratios: 50%, 75%, 100%, 125%,
150%, 250%, 300%.

B Zoom In/Out by mouse wheel

Scroll the mouse wheel up or down when the mouse cursor in the online
display area of online controller. Scroll up to increase the image size, and
scroll down to decrease the image size, 10% adjustment at a pace.

3.7.5 Alarm Switch

Press the Alarm Switcher button in the toolbar at the top line of the
online controller, to enable or disable the alarm function.

3.7.6 Matrix Switch

Press the Matrix Switcher button @ | in the toolbar at the top line of the

online controller, to switch the matrix source from the Matrix window, as
shown in Figure 3.7-6:
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Hatrix configoration

T source
D Sourcell
D Sourcel2
[ sourcens
D Sourceld
D Sourcels
D Sourcelf
D Sourced7
D Sourceld
D Sourceld
D Sourceld
[ sourcet1
D Sourcel2
D Sourcel3
[ sourceta
D Sourceld
D Sourceld

2| ourPUT-1

| ourewr—3

OUTPUT-2

OUTPUT—4

Figure 3.7-6 Matrix

3.7.7 Monitor Window

1. Show output information

You can display the output information on the screens which is used to
observe the relationship between output module and screen.

Click Show output information button

T | in tool bar, it is used to

enable/disable to highlight the output interface information and the brim of
the display screens on the display screens, as shown in Figure 3.7-7:
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Figure 3.7-7 Show output information

Then press the Show output information button again to cancel the
display status, the information of the input interfaces will be hiden.

2. Monitor window
B Marker

Click a monitor window in the display area in online controller, press
Marker Visible Switcher button M | to display or hide the marker on the
selected monitor window.

B Audio Source

Click a monitor window in the display area in online controller, press
Choose Audio button ¢f |, thus the audio source of this monitor will be

broadcasted, and there will be a speaker icon at the top right corner of the
monitor window, as shown in Figure 3.7-8.

Signal

Figure 3.7-8 Set Audio Source
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® Volume Control

Use the volume bar | 4l ) in the toolbar at

the top line of the online controller to adjust the sound level. Drag the
slider to the left for volume down, and to the right for volume up. Press the

volume button #il | to mute the volume, and the icon will changed as| #s.

B Tips

* The shortcut buttons of Alarm Switcher , Marker Visible Switcher

button| M | and Choose Audio | é3 | could be available only for the current

template labeled in playing status.

3.7.8 Main Window

1. Set as Main Window

In Editor interface, select the target monitor window in a layout, and set its
View—-> Main Window item to be selected in its Element Prop pane, as
shown in Figure 3.7-9, thus this monitor window will be selected as the
Main window.

"1ew .

Property | Value

Main Window

Video Format Ensabled

Format Detective 1080T60 ...
Marker Enabled D
TC Enahled L]

Figure 3.7-9 Set as Main Window in Element Prop Pane

There will be an M icon at the top right corner of the monitor window, as
shown in Figure 3.7-10:
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Hame : |:1:|T|{-:-1'Lit-:-r

Hame '::4:'T|Tn:-nitn:-r

0, 575, 540] 40, 575, 540]

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
AL
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

Figure 3.7-10 The Main Window Icon on the Monitor Window

2. Select Signal Source for the Main Window

After switching to the control interface, designate the signal source to the
main window by the following two methods:

O Double click any monitor window on the layout, the signal source
of this monitor will be displayed in the main window.

O Drag a signal source from the Input Source List to the main
window on the layout interface, it will be displayed in the main
window.

3.7.9 Full Screen

There could be a full screen layout in a wall, which you can arrange some
important signal sources in it.

Create the full screen layout by clicking Full Screen | & button in Layout

page, then you can switch to the full screen layout by the Full Screen| o™
button on Control interface.

B Tips

* There could be only one full screen layout in an aurora project.

1. Configure a Full Screen Layout

Follow the instructions below to configure a full screen layout:
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Step 1 Switch to Full Screen layout

First, click Full Screen | @ button in Layout page, it will open the blank
full screen layout , as shown in Figure 3.7-11:

[‘pEvice | source | vibeo waL [ Lavour |

DEIDEEE

coli= el

Figure 3.7-11 Open the Full Screen Layout

The full screen layout name is “ wall name+_fullscreen_" by default, and

its tag is in highlight blue.

Step 2 Set full screen monitor window

Add and arrange monitor elements on the full screen layout, there will be
selection box at the bottom right corner of each monitor window, as shown

in Figure 3.7-12:

[(DEVICE | sourcE | vIDbEo mALL | LavouT |

DEDEEEERER

|[Element Brop | Model Frop

| Moni tor

~

Source Aspect... |Reserved

[~]]..-

G

Starting X—Co... |48

Starting VCo. .. |0

Width 2, 784

Height 1,620

MD Display Mode [Outside Moni tor

|| View

Property

FullSereen Monitor

Property |

Video Format Enabled |[[] .
Format Detective None |V| L
Marker Enabled O
TC Enabled O

{ a1 .

#xall=_ fullsereen_

3438 , 313

Video Loss Di...

Ll

Figure 3.7-12 Select the Full Screen Monitor Property
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Set one of the monitors as the full screen monitor:

B Method No.1: Set the full screen monitor window icon. Choose one of
the monitor window on the full screen layout, and tick off its selection
box at the bottom right corner of the window as the full screen monitor
window icon. Thus, the chosen one is the full screen monitor.

B Method No.2: Set the FullScreen Monitor property. Choose one of the
monitor window on the full screen layout, and set its View—>
FullScreen Monitor item to be selected in its Element Prop pane.
Thus, the chosen one is the full screen monitor.

There will be red tick added to the full screen monitor.

Step 3 Save the Full Screen layout
Click save button to save the modification on the full screen layout.

Step 4 Switch to normal layout

Click Exit Full Screen 9 button, click the other layout tag or open another
layout, it will exit the full screen layout editing page. The modification of
the full screen layout will not affect the other normal layouts.

2. Display the full screen layout

After finishing the configuration of the full screen layout, click the control
03 button in the status bar, it will switch to the control interface, as shown
in Figure 3.7-13:

[EJAarors Bulti-image System Controller

Signal Signal Signal Signal

Signal Signal Signal Signal

Signal Signal

Signal Signal Signal

& online - 192.168.1.70
Figure 3.7-13 Control Interface
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First, click the layout of Playing status in the left Layout pane, then this
layout will be displayed in the working area of control interface.

Second, select one of the monitor windows in current displayed layout,

and click Full Screen| g™ | button on the tool bar, it will switch to the full

screen layout and play it on the video wall, the signal source of the
selected monitor window will also be displayed in the FullScreen monitor
window of the full screen layout.

At last, click full screen g button again, it will pop up a closing prompt,as
shown in Figure 3.7-14:

x

? Fullsecreen window 1= opening Sure to close 117

Tes o Cancel

Figure 3.7-14 EXxit Full Screen

Click Yes to confirm the exit, and it will display the last layout before
switching to the full screen layout.

3.8 Linkage With the Supervisory Monitor

Aurora system could set up a linkage with LMW-550-SE supervisory monitor
through SDI interface, the connection is as shown in Figure 3.8-1:

MONITOR1 MONITOR2 MONITOR3
MONITOR4
MONITORG
MONITORS
R LMW-550-SE
11N1~4
L] S0 OUT1~4
N . AURORA-1600

Figure 3.8-1 Linkage Between Aurora and Supervisory Monitor
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Set up the control relationship by the following methods:

1. Virtual Control Panel

Click LCD | B button on the control interface, it will prompt a virtual LCD

button panel, as shown in Figure 3.8-2:

= LCD¥irtualButton x|

i) ButtonState

ineuT [l MuTe [llvorume [l mEnU ur [l pown [l enTer [l PoweR
F1 F2 F3 | A v > F4

Close

Figure 3.8-2 Virtual Control Panel

The higher characters on these buttons on the virtual control panel are
corresponding to the remote controller and the control buttons of
LMW-550-SE, and the lower characters on these buttons on the virtual
control panel are corresponding to the keyboard, as shown in Figure
3.8-3:

Remote controller and control buttons
of LMW-550-SE
Keyboard

Figure 3.8-3 Buttons Mapping Relationship

The mapping relationship of the all these buttons are as shown in the
following table:

INPUT F1 Signal selection button
MUTE F2 Mute button

VOLUME F3 Volume adjust button
MENU < Monitor main menu button
A A Up button

v \J Down button
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ENTER > Confirm button
POWER F4 Power button
2. Keyboard

3. AURORA-RCP
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